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PREFACE 

Welcome to the Operator’s Manual for the Conviron Central ManagementTM (CM) System. This 

Manual has been developed to assist those responsible for remotely monitoring and operating 

Conviron growth chambers. The Manual is provided to all clients who have purchased a 

chamber(s) with Central Management. 

The manual is structured to provide step-by-step instructions. Clients will find sufficient detail 

including figures, diagrams, and graphics to remotely monitor and operate the chamber without 

issue. However, given that installations are specific to each facility and that facilities may have 

unique circumstances, additional information or assistance from Conviron may be required. In 

such cases, contact information is provided on the following page. 

This equipment is only to be used by authorized personnel – that is, personnel who have been 

trained on the proper use of the equipment and who have read this manual. 
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SERVICE & TECHNICAL SUPPORT 

Conviron welcomes the opportunity to provide assistance and to answer any technical questions 

related to the start-up, use and general technical support and troubleshooting of the Central 

Management system.  

Before contacting Conviron, please check the following: 

 Read this Operator’s Manual in its entirety for information about the feature(s) with which 
you are experiencing trouble. 

 If the problem persists and/or you require additional assistance, please collect the 
following information prior to contacting Conviron: 

 Serial Number – The serial number of Central Management is located on the serial 
card on the side of the computer or on the Installation Media 

 Software version number of Central Management – Open Central Management and 
then select Help > About. A dialog box appears, showing the software version 
number. 

 A description of the problem 

 A description of what you were doing before the problem occurred 

 

 

 

Head Office 

Technical Services 

Conviron 

590 Berry St. 

Winnipeg, Manitoba, 

Canada R3H 0R9 

Visit www.conviron.com for global service contact information. 

http://www.conviron.com/
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EULA - CONVIRON LICENSE AND WARRANTIES FOR 

CENTRAL MANAGEMENT SOFTWARE AND HARDWARE 

Controlled Environments Limited, Controlled Environments Inc., Conviron Europe Ltd., and 

Conviron Germany GmbH, all hereinafter referred to as Conviron. 

Software License 

The Central Management software (the “Software”) which accompanies this End User License 

Agreement (the “Agreement”) is the property of Conviron or its licensors and is protected by 

copyright law. While Conviron is the legal and rightful owner of the Software, you will have certain 

rights to use the Software following your acceptance of this Agreement. Except as may be 

modified by an Addendum to this Agreement, your rights and obligations with respect to the use of 

this Software are as follows: 

You may: 

1. Use one copy of the Software on a single computer; 

2. Copy the Software onto the hard disk of your computer and retain the original for archival 
purposes; and 

3. After written notice to Conviron, transfer the Software on a permanent basis to another 
person or entity, provided that you retain no copies of the Software and transferee agrees 
to the terms of this Agreement. Your license shall be terminated at the time of transfer. 

You may not: 

1. Copy the documentation which accompanies the Software; 

2. Sub-license, rent, lease or assign any portion of the Software; 

3. Reverse engineer, decompile, disassemble, merge, modify, translate, make any attempt to 
discover the source code of the Software, or create derivative works from the Software; or  

4. Use a previous version or copy of the Software after you have received a disk replacement 
set or an upgraded version as a replacement of the prior version. 
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Warranty for Central Management Software 

Conviron warrants the Software and media for a period of ninety (90) days from the date of 

installation or one hundred and twenty (120) days from the date of shipment from the factory, 

whichever comes first, provided the Software is delivered to you by Conviron, or to a Conviron 

authorized distributor or agent. This warranty applies only if you are the original licensee of this 

copy of the Software. Conviron warrants that the media on which the Software is distributed will 

be free and clear from defects during the warranty period stated above. 

Conviron warrants that the Software, if unaltered, will conform to its program specifications during 

the warranty period stated above. This warranty shall only apply where the Software is properly 

used on a computer for which it was designed. Your sole remedy in the event of a breach of this 

warranty will be that Conviron shall, at its option, make the Software and/or media operate as 

warranted by making the necessary corrections or replacing the Software and/or media with 

functionally equivalent Software and/or media, or terminate your license and refund the money 

paid by you for the Software and/or media, upon return of all of your copies of the Software. 

Conviron does not warrant that any other defects will be corrected or that the operation of the 

Software will be uninterrupted or error-free. 

Conviron’s obligation under this warranty is void in its entirety if the Software is improperly 

installed, abused, misused, neglected or altered, or if damaged by flood, fire, or any act of God. 

Any re-configuration of the Software without the prior consent of Conviron shall be considered 

tampering and will void the warranty in its entirety. Where the Software cannot perform properly 

due to conflicts with user installed software or hardware, this warranty shall not apply. 

Warranty for Central Management Hardware 

Conviron warrants Central Management hardware against defects in components or parts for a 

period of twelve months from the date of acceptance, or fourteen months from the date of 

shipment from the factory, whichever comes first. Conviron will replace or repair at its option, 

without charge, such defective parts or equipment. Conviron’s obligation under this warranty is 

void in its entirety if the equipment is improperly installed, or is in any way abused, misused, 

neglected, or altered, or if damaged by fire, flood, or acts of God, or if the serial number plate has 

been altered, defaced, or removed. Freight and labor charges incurred in replacing or repairing 

such defective parts are included in the coverage provided by the warranty. The customer is 

responsible for all customs and duty charges where applicable. Conviron shall not be liable for 

any loss or damage, including incidental or consequential, due to operation failure of the Central 

Management PC or its components. 

THE ABOVE SOFTWARE AND HARDWARE WARRANTIES ARE EXCLUSIVE AND IN LIEU OF 

ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED 

WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-

INFRINGEMENT. 
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Disclaimer of Damages 

In no event shall Conviron (including its directors, officers, employees and agents) be liable for 

any special, consequential, indirect or similar damages, including but not limited to any lost profits 

or lost data arising out of the use or inability to use the Software or Central Management PC, even 

if Conviron has been advised of the possibility of such damages. Some jurisdictions do not allow 

the limitation or exclusion of liability for incidental or consequential damages, so the foregoing 

limitation or exclusion may not apply to you. In no case shall Conviron’s liability exceed the 

purchase price for the Software, media, and/or Central Management PC. 

General 

This agreement shall be governed by the laws of the Province of Manitoba, in Canada, with the 

courts of the Province of Manitoba having exclusive jurisdiction. 

PRECAUTIONS 

The following symbols are used throughout this manual to draw your attention to important 

warnings, guidelines and product information. Please take note of their respective meanings. 

 

 

 

 

The “HAZARD WARNING” symbol is used whenever a hazard exists which could 
cause personal injury or potential equipment damage, and requires correct 
procedures/practices for prevention. 

The “IMPORTANT INFORMATION” symbol is used to identify operating procedures 
which must be followed to ensure smooth and efficient operation. 

The “PLEASE NOTE” symbol is used to draw attention to additional information 
which may assist in the operation of the equipment. 
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HAZARD WARNINGS 

Please note the following Hazard warnings before operating this equipment: 

 

 Users of Central Management must be aware that changes they make will 
impact electrical and/or mechanical operations of a chamber(s) at a location 
that they are not visually monitoring and/or physically present at. 

 Operating the chamber remotely, while others are occupying or servicing the 
chamber, COULD BE HAZARDOUS AND MAY RESULT IN PERSONAL 
INJURY to service or other on-site personnel. As such, manipulation of 
parameters via CM must only be performed when Users have taken 
appropriate safety precautions including having established that NO ONE 
ELSE is occupying or servicing the chamber while using CM software. 

 Conviron Central Management is normally the connection point to several 
external alarm monitoring systems. Consequently, it is important to 
understand the following: 

 Users of CM must have permission to connect to CM and if the work 
requires rebooting or shutting down the equipment, the onsite authority 
must be informed such that this procedure can be accomplished safely. 

 Be certain of the correct procedures for remote connection, login and 
disconnect. It is possible to select the incorrect “quit” methodology and 
shutdown” the CM system rather than simply disconnecting the remote 
connection. If the system is shutdown, all subsequent chamber alarms 
occurring would not be recognized by CM, thereby failing to send out 
alarm notifications. Once shutdown, the CM system would require a 
manual startup. 

 While the CM system shows many of the chambers’ parameters, alarm 
settings and physical conditions are not available to the remote user. 
Any type of change, or diagnostics, is best performed when onsite 
personnel are available to work with the remote user. 

 Central Management is an optional feature. If Central Management is being 
used it becomes inextricably linked to the use of the control system and 
therefore, both the Central Management Manual and the Operator’s Manual 
for the control system must be read and understood in their entirety prior to 
operation. 
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1 INTRODUCTION 

1.1 Contents 

This Manual explains how to use the Conviron Central Management (CM) system to remotely 

monitor and operate Conviron growth chambers based on CMP series control systems. It is 

intended for people who are responsible for managing and / or operating the growth chambers 

within their facility, but who are not expert users of Microsoft Windows.  

This Manual contains seven chapters. 

Chapter 1.0 Introduction 

Describes the organization of the Manual, its document conventions, the major features of the 

Central Management system, and how to contact Conviron Client Services.  

Chapter 2.0 Quick Start 

Explains how to get started. Instructions are provided including setting up the computer and 

chamber network and using the Central Management application, along with a brief outline of the 

user interface. A step-by-step approach has you working right away. It also describes how to get 

online help and further assistance. 

Chapter 3.0 Using Central Management 

Explains how to use all Menu functions including adding chambers and subscribers to the Central 

Management Network, organizing chambers in folders, planning experiments, viewing Activity 

Logs, and Extracting data or alarms. 

Chapter 4.0 Chamber Activities 

Outlines the necessary day-to-day activities in a workflow format to aid the Administrator in using 

the software effectively. Included are: Monitoring chambers using the Thumbnail Status, Email 

Alerts, Chamber Panel and Viewing alarms, and configuring responses. 

Chapter 5.0 Remote Chamber Programming 

Describes how Users access and work with the Central Management system and Chambers from 

Network, Internet locations and alternate devices. 

Chapter 6.0 System Maintenance and Troubleshooting 

Describes the necessary details for the configuration of backups, Central Management system 

settings, Alarm responses and network addressing, and restoration of Central Management 

software. 
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Chapter 7.0 Central Management Software Installation 

Provides instructions on learning how to install the Central Management software-only component 

of the Conviron Central Management system. 

Glossary of Terms used in this Manual. 

1.2 Document Conventions 

To help you find and understand information, the following document conventions are used in this 

Manual. 

Table 1.1: Conventions 

Convention Meaning 

 Information that isn’t procedural, but will help with the use of Central 
Management.  

 
Information that is essential to performing a procedure. 

Bold text The name of a section in this Manual or another Manual.  

Italic text The name of the file or directory. 

Typewriter font Text that you enter. 

“In Quotes” Menu names and menu selection options 

key1+key2 Press and hold the first key while you press the second key. 

key1, key2 Press and release the keys sequentially. 

 

1.3 Central Management System Features 

The Central Management system is a Microsoft Windows based remote control and monitoring 

application for Conviron growth chambers equipped with CMP series control systems. 

Using Central Management, you can operate and monitor growth chambers from a central 

location. The Central Management system makes it possible for Conviron Client Services to 

perform maintenance and troubleshooting tasks remotely. 

Tip: 

Important: 
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1.3.1 Central Management system features 

Using Central Management, you will be able to perform the following tasks remotely: 

 Tell, at a glance, the status of any chamber on the network 

 Operate all chambers on the network from a central location 

 Receive Email Alerts for Urgent Alarms 

 Download alarm and log data in text or .csv format 

 Gain online access to Central Management system using Windows Terminal Services 

 Take advantage of Central Managements built-in Web Reporting service 

 Mirror the CMP6060 control system local display 

The Central Management System includes software version 8.5 and optional hardware. 

1.3.2 Optional Central Management hardware 

 Pentium processor 

 8 GB RAM 

 2TB hard drive 

 19 inch monitor 

 Conviron Restore Drive 

 Dual 10/1000Base-T Ethernet cards 

 Sanity Card ensures fail-safe operation 

 DCS - Dry Contact Alarm Reporting System 

 Microsoft Windows Operating System 

 

1.3.3 Central Management Hardware Options 

 Autodialer 

1.3.4 Central Management Software Features 

 The Central Management system has all the features of the previous Central Control 
system (CCS) with many additions to meet the changing needs of our clients. 

 Central Management is a .NET 4.0 application. The application runs on Windows 7 and 
Windows 10. 

The hardware for the Central Management™ system reflects current PC technology, 
including Conviron’s additions of Conviron Drive imaging and Restore, Sanity / Alarm 
card, Dry Contact System (DCS), dual Network cards with three display monitor 
capability, and Daily Automated Backup. A single LCD display is standard. 
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 The Central Management core, (CMService.exe) runs as a system service (it is not tied 
to a user account) allowing multi-user security access. Central Management is the User 
Interface and may be closed, without effect to logging, alarms, or email. 

 Central Management is network-independent. Addressing can conform to Users’ needs 
to permit integration and coexistence in existing Networking Structures (some 
restrictions apply to legacy equipment). 

 Direct online Central Management system access via network or optional modem using 
generic Windows Terminal Services on PCs or Macs and Mobile Devices. 

 Windows 10 operating system shares PC resources more efficiently, allowing the 
Central Management PC to be a fully functional workstation. 

 Central Management software can run on Client hardware without the Conviron’s 
hardware option; however, the Local Audible alarm, Sanity reset, Autodialer, and 
Building dry contacts options for Alarm alerting would not be available. In this situation, 
Email Alerts is the only alerting method. 

 Central Management has a built-in Web Reporting service. This provides Status 
Thumbnails, Data and Alarm logs, Trend-Graphing, Service History, and Data 
downloading to a remote user by way of a web browser. The Web Reporting service is 
suitable for users with read-only access who need to see what the chambers are doing. 
Web Reports are available anywhere by way of Internet or Intranet web browsers. 

 A full featured calendar based Experiment Scheduler documents the start-stop date, 
chamber ID, User Name, Experiment Name, and notes. Information is presented on a 
Gantt style or grid chart display. 

 The Scheduler tool has Chamber Usage tracking and reporting by Chamber or User, for 
charge out purposes. Reports are printable or may be saved in text and HTML formats. 

 Central Management’s chamber properties record contains editable fields of ID, Model, 
Serial, Notes, Service History, Service Notes, Experiments, Subscribers, and a 12-
character description field. The chamber database keeps all the related items to a 
chamber and experiment together in one place. 

 The email alarm reports are configurable, allowing you to determine which alarm will 
generate an email alert. The email system is organized for a single Network subscriber 
who gets every chamber alarm message and individual chamber subscribers who see 
only alarms from their particular chamber(s). An Email Alert message links to the Web 
Report Alarms page for a particular chamber. 

 Trend graph allows for instant multi-day, (up to 1 year) multi-point graphs and printouts, 
(optionally) including alarm condition indicators. 

 Files are stored on the Central Management system in standard Comma Separated 
Values (CSV) format. Files are organized by chamber ID, in DataLog, Alarmlog and 
Programs directories. The data file is stored as a daily archive and filename-branded 
with year - day of the year – Chamber number (e.g., 07124001.log) format. 

 Dry Contact System has a programmable reset interval to prevent masking of second 
and tertiary alarm actions. 
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 Configurable settings for Email, Web Reports, Dry Contact System, and Alarm Actions 
are flexible to work the particular environment.  

 Easy test verification features for Email, Dry Contact System and Sanity. 

1.3.5 Virus Protection 

The Conviron hardware includes Microsoft Defender. As Virus protection is vital for any internet-

connected PC, it is strongly advised that an Anti-Virus program is installed. The Conviron Central 

Management system includes Microsoft Defender by default. As most clients have an existing 

preference for an Anti-Virus program, be sure to read Chapter 6 regarding Central Management 

requirements and Third Party Security protection. Restore and Backup operations are explained in 

detail in Chapter 7, Section Software Restore, starting on page 137.  

1.3.6 Chamber Networking 

The Chambers and Central Management system do not have special requirements for networking 

hardware. Connecting the chambers with a local private network is the default installation type. 

Expanding or connecting to the building services can be added at any time, as the Central 

Management system is ready for the additional connection. The second Building Network card is 

set to auto-configure (DHCP). Details on configuring TCP/IP networking with the Central 

Management system are found in Chapter 6. 

1.3.7 Online Assistance 

Conviron Client Services offers online assistance with all our products, and this is facilitated by 

our ability to connect to your Central Management system network. This can be via the Internet 

(analog modem optional) or LAN connections, whichever is appropriate for your IT Building 

Services to supply. For your security, take note that we use several static TCP/IP addresses for 

Internet connections to your facility. These addresses can be added to your firewall rules, allowing 

secured access to Central Management: 207.54.102.226 primary and 207.54.102.229 secondary. 

1.3.8 Customization 

The decision that must be made, is how the Central Management system is to be used in your 

specific environment. This can wait until all the features and possibilities are understood, within 

the framework of the users’ workflow. The Email, Remote Communication, and Web services can 

be activated at any time by adding the necessary settings to Central Management’s settings 

panel. See Central Management System Features to select the options that best fit your needs. 

1.3.9 References 

This Central Management Operator’s Manual explains how to use Central Management. If you 

need assistance using Microsoft Windows, a Conviron control system, or any of the other software 

applications included with the Central Management System, refer to one of the following user 

guides: 
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 Microsoft Windows User’s Guide 

 Conviron CMP4030 User’s Guide 

 Conviron CMP5090 User’s Guide 

 Conviron CMP6050 Operator’s Manual 

 Conviron CMP6060 Operator’s Manual 

 Conviron CMP37660 User’s Guide (3000 Host) 

 

CMP4030, CMP5090, CMP6050, CMP6060, and CMP37660 are trademarks of Controlled 

Environments Limited. 

Conviron is a registered trademark of Controlled Environments Limited. 

Microsoft, Excel, Windows, Windows 7, and Windows 10 are registered trademarks of Microsoft 

Corporation. 
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2 QUICK START 
The Central Management program runs in the Windows Operating System so you need a basic 

understanding of how to work with Windows applications. Central Management can be run on 

Windows 7 and Windows 10 Professional. Microsoft .NET v2.0 is required. 

This chapter is intended for readers who have little experience with a Central Management 

system or Windows. In this chapter, you will learn: 

 How to setup the Central Management™ hardware 

 To understand the features and startup mode 

 To Login as Administrator or Guest 

 How to start and quit Central Management™ 

 About the Central Management™ system 

 To setup your Chamber Network 

 How to get online help 

2.1 PC Hardware Setup 

Table 2-1 lists the recommended connection sequence. 

Table 2-1 Hardware Connection Sequence 

Component Action 

1 Connect monitor and PC power cables to power bar. 

2 Connect monitor, mouse, and keyboard to PC. 

3 Connect Ethernet cables to chamber network, PC, and switch. 

4 Connect building network cable to PC and building services. (Optional) 

5 Connect Dry Contact System cable to PC and DCS box. 

6 Connect DCS to autodialer and/or building alarm system. (Optional) 

7 Connect modem cable to modem and the other end to phone outlet. (Optional) 

8 Connect autodialer to modem “phone jack” (Optional) 
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Figure 2-1 Dell CM Computer Back View 

 

2.2 Network Description 

Inter-connections between the Chamber control systems (CMP4000, CMP5000 and CMP6000) 

and the Central Management system PC utilize industry standards to ensure that a proven 

network technology is provided for the Conviron Chamber Network. 

Conviron, by default, provides a private network for the chambers and Central Management 

system. The hardware and equipment is non-proprietary and can coexist in most TCP/IP based 

Ethernet networks. 

Display 

Keyboard 
Mouse 

DCS 

Chamber 
Network 

Building 
Network 

To merge into a building network, the addressing scheme must be disclosed and 
Conviron equipment preconfigured with static network addresses. 

The CMP4000 to CMP5000 control systems have several possible Ethernet LAN 
configurations, but there are certain restrictions. These options are available only with 
the control system software version 6.22. 
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2.2.1 Conviron Controller Ethernet LAN Configurations 

The Chamber may be: 

 Integrated into Client’s network as fixed (static, not DHCP) IP address in the existing 
User’s LAN address scheme. 

 Integrated into user’s network as separate subnet, using a private addressing scheme, 
but connected to the user’s LAN hardware. 

 Connected to Client’s network via a router, allowing the physically separate hardware 
and addressing schemes to communicate to each other. 

 Connected to Client’s network via a Central Management™ system, allowing the 
physically separate hardware and addressing schemes to communicate to each other 
(Conviron Default). 

 Incorporating VLAN technology, chamber clusters in separate locations (floors or 
buildings) can be “grouped” as a single private LAN and monitored by a single CM 
system. 

2.2.2 Central Management Networking 

Connect the Chamber and Central Management PC to the Ethernet switch using the same 

Ethernet cabling as the Chamber.  

1. On the computer screen, click Start > Control Panel > Network and Internet > View 
network status and tasks > Change adapter settings. 

2. Right-click on the Chamber Network, and then select Properties.  

The Network Properties screen appears (Figure 2-2). 

 

Figure 2-2 Network Properties 

1. Scroll down and select Internet Protocol Version 4 (TCP/IP), then click on the “Properties” 

button. 

Figure 2-3 Internet Version 4 Protocol Properties appears. 
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Figure 2-3 Internet Version 4 Protocol Properties 

The Building Network connection is optional and must be configured by on site I.T. staff. 

The Central Management system is installed with 192.168.0.100 as the default Network address. 

Chambers also default to 192.168.x.xx for the Central Management network, but their address 

must be set, so each Chamber has a unique ID (address). 

Assuming the first Chamber is set to 192.168.0.1 (Unit ID 001), set each Chamber to have 

sequential IDs (1,2,3 ...and so on). We reserve the first (100) addresses for legacy chambers, 

CMP4000 and CMP5000. The remaining addresses of 192.168.0.101 to 254 are suitable for 

selection for CMP6xxx Chamber control systems. 

2.2.3 CMP4000-5000 Networking 

To set the Chamber Addressing: 

1. Power on the Chamber’s control system.  

2. From chamber status screen, tap the Options icon, and then locate the Group and Unit 
numbers. 

3. Tap the group and unit buttons, Figure 2-4 Group and Unit Address, to set the 
control system’s Group to 0 and Unit ID to 1-99 or the desired TCP/IP address. 

 

Figure 2-4 Group and Unit Address 
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4. Once the Group and Unit are set, tap Exit to save the change and exit.  
A pop-up window appears, warning “Net Address changed you must cycle power.” 

5. Tap OK to continue.  

After the restart, the new Unit ID appears on the control system status display, Figure 2-5 

CMP5090 Status Display. 

 

Figure 2-5 CMP5090 Status Display 

2.2.3.1 Addressing Format Requirements 

 IP address is 192.168.x.yy 

 x is the first digit of the address (Group). Range is 0 to 9 

 yy are the last two digits of the address (Unit). Range is 1 to 99 

 Subnet mask is fixed at 255.255.255.0 

 Setting the Unit ID to 001 will set the TCP/IP address of the chamber to 192.168.0.1. 

 

2.2.4 CMP6050 Networking 

The CMP6050 can be connected to a Central Management system on an Ethernet Local Area 

Network. To enable communications, the control system must be connected to the network and 

configured with a suitable network address. There are two places where the control system IP 

addresses must be set-up: At the control system and at the Central Management PC. 

There are two network addresses to set in the CMP6050: 

CMP Address: Address or ID of the control system within the network. 

Netmask: Divides an IP address into subnets and specifies the 

Remember, the chamber must be set to an address on the same network (x) as the 
Central Management PC (default – 192.168.0.100). 
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network’s available host. 

Central Management Enables or Disables CM communication  

CM Address: Central Management IP Address  

 

 

 

To set the Chamber Addressing: 

1. From the status screen, tap the ID button  to access the network configuration 
(Figure 2-6).  

 

Figure 2-6 CMP6050 Network Configuration 

 

 

A valid IP address is needed for the “CM Address” value when there is a Central 
Management system present. If there is no Central Management system present, the 
CM Address should be set to ‘Disabled’ 

If Disabled appears, tap Disabled, and then press the Up arrow key to change 
Disabled to Enabled. Press the Enter key to save. Use the controller keys (Figure 
2-7). 
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Figure 2-7 Controller Keys 

2. To change the address numbers, touch each individual numerical field. A pop-up 
keypad (Figure 2-8) appears every time a field is accessed. 

 

Figure 2-8 Keypad 

3. Once all the addresses have been entered, tap Exit . 
A pop-up warning window (Figure 2-9) appears to confirm the numerical entries. 

 

Figure 2-9 Save Changes 

4. Tap Yes to save the changes or tap No to discard the changes.  
Tap Cancel to return to the previous screen and re-enter any numerical address errors. 
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2.2.5 CMP6060 Networking 

The CMP6060 can be connected to the Central Management system on an Ethernet local Area 

network. To enable communications, the control system and the Display must be connected to the 

network and configured with a suitable network address. There are two places where the control 

system and Display IP addresses must be set-up: At the control system/Display and at the Central 

Management PC. 

There are three network addresses to set in the CMP6060: 

Control System Address Address or ID of the control system within the network 

Netmas: Divides an IP address into subnets and specifies the 
network’s available host 

Display Address Address or ID of the HMI Display within the network 

Netmask Divides an IP address into subnets and specifies the 
network’s available host 

Central Management Enables or Disables CM communication  

CM Address Central Management IP Address  

 

 

 

A valid IP address is needed for the “CM Address” value when there is a Central 
Management system present. If there is no Central Management system present, the 
CM Address should be set to ‘Disabled’. 
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To set the Chamber Addressing: 

1. On the control system screen, tap ID  in the top banner to access the 
network configuration (Figure 2-10). 

 

Figure 2-10 CMP6060 Network Configuration 

 

2. Tap on any of the values to bring up a dialog box to edit the settings. 

There are two dialog boxes: one for the HMI settings (Figure 2-11) and one for the PLC/CM 

settings (Figure 2-12).  

 

Figure 2-11 CMP6060 HMI Network Settings 

The HMI Network setting dialog cannot be canceled and will reboot the HMI once the 
Apply button is pressed. 
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Figure 2-12 CMP6060 PLC and CM Network Settings 

3. Tap on any of the values to bring up a keypad to enter the new values.  

4. Tap the Enable/Disable CM to toggle between enabling and disabling CM. 

2.3 Startup and Logon 

2.3.1 Start-up 

When the PC is powered on, it will automatically start the Central Management service. No user 

interaction is required. Data logging and alarming sequences are handled by the Central 

Management service, which is always operating when the PC on. 

2.3.2 Login as Administrator 

After a power outage, the PC will power up automatically starting the Operating System and the 

Central Management service. The user must log in with a Conviron ID. 

2.3.3 Administrator Login Credentials 

The administrator username is conviron with the password CXyyyy, where yyyy is the work 

order of the Central Management system, which can be referred to on page (i) of the Central 

Management System Installation Manual.  

If this information is lost, please contact Conviron Client Services, with your Central Management 

System serial number (located on the Central Management system side panel). The Administrator 

login allows the user to run the Central Management System, which permits full access to the 

chambers and management of all chamber-related information. 

2.3.4 Configuration 

Additional hardware options provided by Conviron are already pre-configured to a site’s existing 

chamber list (if known). Software installations will need to add chambers to the Central 

Management system list to enable communications with the Central Management system. 
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2.4 Starting and Quitting Central Management 

Your system has been preconfigured to automatically run Windows and the Central Management 

software whenever you start the computer. 

Normally the Central Management service is always active. However. the Central Management 

Operator Application can be started when required and closed when not needed. 

For software updates and specific service tasks, the Central Management service may need to be 

stopped and restarted. Refer to Chapter 7, System Maintenance and Troubleshooting, on page 

108 for details. 

2.4.1 Starting the Central Management application 

To start the Central Management application program, double-click the Central Management 

icon . 

2.4.2 Quitting Central Management 

There are two ways to quit Central Management: 

 From the File menu, select Exit (Figure 2-13). 

 

Figure 2-13 Exit CM 

 Double-click the  button in the top left corner of the Central 
Management window. 

2.5 Understanding the Central Management Program Window 
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2.5.1 Menu bar 

The menu bar runs along the top of the window and provides access to all of the application 

commands (Figure 2-14). 

 

Figure 2-14 Central Management Status Display 

2.5.2 Chamber Status 

The Chamber Status Thumbnails window displays the current status of each growth chamber 

currently connected to the network (Figure 2-14). 

Organize chambers in folders, and then access them by clicking the Chambers List displayed on 

the right portion of the window. (See Chapter 3, Using Central Management, on page 27 for 

directions on using folders.) 

2.5.3 Thumbnail 

Individual Thumbnails display the current status of all chambers connected to the network. 

From a chamber’s thumbnail display (Figure 2-15), you can read the chamber’s zone selectors 

and alarm status. See Chapter 3, Using Central Management, on page 27 for more information 

about reading thumbnails. 

 

Figure 2-15 Thumbnail Display 

Menu Bar 

Actions Menu 

Thumbnail 
Display 
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2.5.4 Actions List 

The Actions list comprises a list of the most used commands for working with Central 

Management. If hidden, click on the roll-up button to reveal the entire menu. 

 

Figure 2-16 Actions List rolled up 

2.5.5 Virtual Login Window 

Right-click on a chamber thumbnail display to activate the chamber menu (Figure 2-17). 

Select Virtual Chamber to log in and work with the chamber control system. The control system 

display that appears may vary, depending on the Chamber control system type. For more 

information, refer to Section 4.5, Scheduling Activities, on page 58 and Section 4.12, Software 

Updates for CMP4030 and CMP5090, on page 78. 

2.6 Adding a Chamber to the Status Display 

 

Figure 2-17 Chamber Menu 

 

Chamber Menu 
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Figure 2-18 Virtual Chamber Displays 

1. From the Actions menu, select Edit Chambers (Figure 2-19). 

 

Figure 2-19 Edit Chambers 

CMP5000 
Interface 

CMP6000 
Interface 

CMP6060 

Interface 
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The Edit Chambers dialog box appears (Figure 2-20). 

 

Figure 2-20 Edit Chambers Dialog 

2. To add a new chamber, select Add New. 

3. Type the Chamber ID number as shown on the Chamber control system, then tab to set 
Model Serial, Control System, Notes and Display Name.  
Both the Chamber ID and the control system entry are essential for Central 
Management to function properly with differing Conviron control systems.  

4. Enter the control system type as: CMPxxxx where the x= the four digit numeric model of 
your Chamber. 

5. To edit any record in the Edit Chambers dialog box, select the entry and type in the 
new information. 

The Chamber specifications are especially useful in the Notes area. The Chamber ID and control 

system are the only required entries.  

The Display Name Entry appears on the Thumbnail Display of both Web reports and Central 

Management Dashboard. The Display Name can be 12 characters or less.  

To remove a Chamber entry, click on the column in front of the Chamber ID. Once the row is 

selected, press the Delete key on the computer keyboard. 

2.7 Getting Online Help 

Central Management includes a PDF (Adobe Portable Document Format) copy of the Operator’s 

Manual that can be opened at any time.  
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2.7.1 From the menu bar  

To access the online help from the menu bar, select Help > Help (Figure 2-21).  

 

Figure 2-21 CM Help menu 

The online help Table of Contents appears. 

2.7.2 From within a remote control session  

To access online help from a Remote Access Control or Virtual Login, click the Help icon , or 

from the Help menu, select Help. 

The Help file will open to the table of contents. 

2.8 Known Issues 

 When installing the Central Management software, ensure the default installation 
location is used: C:\Program Files for 32-bit installations and C:\Program Files (x86) for 
64-bit installations. This will avoid a potential Central Management Service startup 
failure.  

 Ensure the Windows Regional and Language settings are set to English Canada. This 
prevents serious Program Editor Spreadsheet errors with time and units. CM expects 
the date format yyyy/mm/dd.  

 The Edit User dialog box requires Username and Email entries. Neither field must be 
empty. If no Email address is provided, insert a blank space.  

2.9 Arranging Windows 

While working with Central Management, you can arrange windows on the Central Management 

system desktop any way you want. Refer to the Microsoft Windows User’s Guide for detailed 

instructions on moving, sizing, and arranging windows. 

2.9.1 Minimizing windows 

Save space on the desktop by shrinking open windows into icons or minimizing the window.  

Click  to minimize the window to a taskbar button. To restore the minimized window to its 

previous size, click its taskbar button.  
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2.9.2 Maximizing windows 

To maximize an icon into a window, click  so that the window covers the entire screen.  

2.9.3 Arranging windows 

After maximizing a window, click  to restore the window to its previous size. 

To learn more about using Windows, refer to the Microsoft Windows Help and Support Center. 

Microsoft includes a self-paced tutorial with Windows. To start the tutorial, from the Windows Start 

menu, select Help and Support. 

2.10 Typical Central Management Screens 

 

Figure 2-22 Central Management 

 

 

Figure 2-23 Web Reports 
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Figure 2-24 Virtual Chamber (Remote Interface for CMP4000/CMP5000 Series control systems) 

 

 

Figure 2-25 Remote Control (Remote Interface for CMP6000 Series control systems) 
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Figure 2-26 Email Alert 

 

 

Figure 2-27 Central Management Service 
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Figure 2-28 Experiment Scheduler 

 

 

Figure 2-29 Trendgraph 
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3 USING CENTRAL MANAGEMENT 
Central Management provides the ability to work with alarm actions to ensure alerts are noticed 

effectively. Logged data can be opened in other applications such as spreadsheets and text 

editors.  

In this chapter, you will learn how to:  

 Understand all menu functions  

 Add Chambers to the network  

 Add subscribers  

 View activity logs  

 Use diagnostics  

 Acknowledge or respond to alarms  

 Schedule experiments 

 Extract data or alarms  

 Export alarm and data to another application or file  

 

 

3.1 Action Panel 

3.1.1 Edit Chambers 

From the Actions menu, select Edit Chambers (Figure 3-1) to add a chamber, remove a 

chamber, or change the key information about an existing chamber record.  

 

Figure 3-1 Edit Chambers 

All menu item functions are explained in this section. For detailed use and workflow 

suggestions, see Chapter 4, Chamber Activities. 
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3.1.1.1 Add or Edit 

1. Click Add New (Figure 3-2), and then enter the Chamber ID number, as set in the 
Chamber control system.  

 

Figure 3-2 Edit Chambers 

2. Tab to add or edit Model, Serial, Controller, and Notes.  
The Controller entry is essential for Central Management to function properly with 
differing Conviron control systems.  

3. Enter the control system type as: CMPxxxx where the x= the four digit numeric model of 
your Chamber control system.  

 

If CMP6060, also enter the IP address of the Display in the HMI address column. 

 

 

The Chamber specifications are especially useful in the Notes area. The Chamber ID 
and control system are the only required entries. 
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3.1.2 Edit Folders 

1. From the Actions menu, select Edit Folders to create and maintain custom chamber 
groups.  

 

Figure 3-3 Edit Folders 

2. Select New Folder, and then enter a custom folder name.  
Custom folder names will be displayed in the lower section of the Chambers panel 
(Figure 3-4). 

 

Figure 3-4 Folder Editing 

3. In the Folders panel, select a folder name.  

4. Select the chamber(s), and then click Add or Remove to update the folder’s list. 

5. Click OK to exit and save changes, or click Cancel to discard the changes. 

The first two categories are system defaults and may not be altered.  

Selecting Show All shows all the configured chamber thumbnail displays on the Status Display.  

Selecting Active Alarms shows only the chambers that currently have active alarms. 
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3.1.3 User Folders 

The remaining categories are user defined and some examples of organization are shown here. A 

newly installed system will not have user defined entries, until they are defined (Figure 3-5). 

 

Figure 3-5 Chambers Folders 

3.1.4 Edit User Account 

From the Actions menu, select Edit Users (Figure 3-6). Adding users to Central Management 

allows the CM Administrator to be able to alert the appropriate persons responsible for chamber 

activity, alarms, and performance.  

 

Figure 3-6 Edit Users from the Actions Menu 

Usage reports and email functions require the chambers to have users associated to them. The 

Email address is optional, but Email configuration must be completed for the Email Alerts to 

become functional (Figure 3-7). 
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See Section 6.1, Email Alerts , on page 94 and Section 7.4, Central Management Software 

Settings on page 125 for additional email setup. 

 

Figure 3-7 Edit Users Dialog Box 

3.1.5 Extract Data 

The Extract Data option lets you choose where to copy the file and other chamber-specific 

information. 

1. Select the chamber (Figure 3-8). 

 

Figure 3-8 Select Chamber 

2. Select the start date (Figure 3-9). 

 

Figure 3-9 Select Start Date 
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3. Select the end date (Figure 3-10). 

 

Figure 3-10 Select End Date 

 

4. From the Extract From dropdown menu (Figure 3-11), select whether the data type to 
copy is alarm or log files. 

 

Figure 3-11 Extract From 

 

5. Click Extract (Figure 3-22). 

 

Figure 3-12 Extract 

 

The Save As dialog box lets you to save the extracted data to any device or location connected to 

the Central Management computer (Figure 3-13). 
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Figure 3-13 Data Extract Dialog 

6. Enter a filename, and then select one of the available formats: Excel Ready (CSV) or 
Tab delimited (Print Ready). 

3.1.6 Scheduler 

The Chamber Scheduler is a powerful management interface to all Chamber information. From 

the Actions menu, select Scheduler (Figure 3-14).  

 

Figure 3-14 Actions Scheduler 
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Figure 3-15 Scheduler Gantt View 

Two views are available for the schedules: the Gantt (Figure 3-15) and the grid (Figure 3-16). 

Both views can be configured to suit your needs. The Tool bar has two items from the Actions 

menu for convenience. 

 

Figure 3-16 Scheduler Grid View 

Experiments are more than records of Chamber usage. They document the User, Chamber, and 

any informative notes that are pertinent to the scheduled experiment. The start and stop dates 

assist the Administrator in determining the duration of all experiments (reports are by Chamber or 

by User). Detailed instructions are found in Chapter 4, Chamber Activities, on page 53. 

3.1.7 Acknowledge All Alarms 

This global command will acknowledge all alarms for all Chambers on the network. 

Acknowledging alarms indicates that you have seen the alarm condition and subsequent 

corrective action, if any, is your responsibility.  
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Figure 3-17 Ack All Alarms 

Acknowledging active alarms stops the local audible alarm and email notification as well as 

changing the state of the chamber display icons of the system tray, thumbnail display, and 

Chambers panel. 

3.1.8 Reset DCS 

Selecting Reset DCS (Figure 3-18) will deactivate the relay of the Conviron Alarm Contacts box 

during an Alarm condition. It will set the N.C. (normally closed) contacts back to a closed position 

and the Green LED (normal) will be illuminated. This feature is provided for backward 

compatibility with autodialer settings used in CCS versions 4, 5, and 6. This function is only 

needed when the DCS reset interval is set to 0 (disabled), or during the Dry Contact System 

reset interval.  

 

Figure 3-18 Reset DCS 
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3.1.9 Activity Log 

From the Actions menu, select Activity Log (Figure 3-19) to review all CM-related network 

events.  

 

Figure 3-19 Activity Log 

Remote Chamber Connections, Email Alarms and tests, Central Management Service status, Dry 

Contact System Relay Status, Sanity Status, and Chamber Communications are all examples of 

the message types stored in the Activity Log.  

The files are located in C:\Program Files\CM\ActivityLogs for 32-bit installations and 

C:\Program Files (x86)\CM\ActivityLogs for 64-bit installations directory. The files are date coded 

for mm/dd/yy.log 

3.1.10 Alarm icons 

Three types of icons (Table 3-1) precede the log message to indicate the urgency of the log entry. 

These icons also appear in the Chambers panel, folders list, indicating the alarm status of the 

individual folder groups. 

Table 3-1 Alarm Status Icons 

Icon Alarm Status Description 

 
IA 

Inactive Acknowledged (or no alarm) 

Information – Confirmation messages.  

Example: login to chamber. 

 
IU 

Inactive Unacknowledged 

Alert – Unexpected conditions, response needed.  

Example: Chamber in database trying to log in. 

 
AU 

Active Unacknowledged 

Error – More serious conditions, response is needed. 

Example: Error sending email alerts. 
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3.2 Chambers Panel 

The Chambers panel (Figure 3-20) controls the display of the chamber thumbnails in the Central 

Management network. Select the grouping you want to display on the Chamber Status thumbnail 

window. 

 

Figure 3-20 Chambers Panel 

All the remaining categories are user defined. Icons indicate the current alarm status of each 

group. For the meaning of each icon, see Section 3.1.10 Alarm icons on page 36. 

The letter abbreviations correspond to the Chamber control systems designations. 

3.2.1 Show All 

The Show All option displays all the chambers, whether or not these are active. 

3.2.2 Active Alarms 

The Active Alarms option shows only the chambers with active alarms. 

3.2.3 User folders 

The entries on the Chambers panel below the white line are folders added by the User to 

organize the Chambers in a logical manner that is appropriate to the User’s needs. 
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3.3 Tools Menu 

3.3.1 Diagnostics 

 

Figure 3-21 Diagnostics 

3.3.1.1 DCS Test 

This diagnostic tool can be used to verify the DCS (Dry Contact System) operation and to ensure 

the alarm contacts correctly signal the Autodialer or Central Monitoring Station. 

3.3.1.2 Send Test Email 

Verify the email configuration is configured correctly by sending a test email to any valid email 

address. Setting for SMTP server and email configuration must be completed in the Settings 

window prior to testing. 

3.3.1.3 Test Sanity Reset 

Select Test Sanity Reset to be certain that the Watchdog Card is working properly.  

Once you click OK in the Sanity Reset Test dialog box (Figure 3-22), the process cannot be 

cancelled.  

 

Figure 3-22 Sanity Warning 

After a time delay of about 40 seconds, the system reboots. The Central Management system 

automatically restarts and runs the necessary services to monitor the Chambers.  

If the sanity reset fails, refer to Chapter 7, System Maintenance and Troubleshooting, on page 

108 for Sanity Card settings and troubleshooting hints. 
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3.3.2 Settings 

From the Central Management menu bar, select Tools > Settings to configure the Central 

Management options. See Chapter 7, System Maintenance and Troubleshooting, on page 108 for 

details on each setting. 

 

Figure 3-23 Application Settings 

The default settings for the Central Management system are documented in chapter 7, System 

Maintenance and Troubleshooting. However, most settings never need to be altered. Email, Mail 

Server, and Web Server settings have site-specific addresses that need to be provided by the 

onsite IT administrator. Refer them to Chapter 7, System Maintenance and Troubleshooting, on 

page 108. 

 

Figure 3-24 Settings Categories 

3.3.3 Network Subscribers 

Network Subscribers are typically system administrators. All Chamber alarm conditions are sent to 

the Network Subscribers. Regular Subscribers are added to the individual Chamber Property 

Subscriber lists. Users appearing in both lists will receive only one email alarm notification. 
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To access the Network Subscribers dialog box (Figure 3-26), from the Central Management 

menu bar, select Tools > Network Subscribers. 

 

Figure 3-25 Network Subscribers 

Users can be added to the Network Subscribers list by clicking on the drop-down list box and 

selecting one or more of the displayed names (Figure 3-26).  

If this list is empty, then first add users with the Edit Users option from the Actions menu. 

 

Figure 3-26 Network Email Subscribers 

3.3.4 CMP6000 Alarm Triggers 

Select Tools > CMP6000 Alarm Triggers to set the default actions for all CMP6000 series 

Chamber control systems. 

 

Figure 3-27 CMP6000 Alarm Triggers 
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3.3.4.1 Global Settings 

The default Alarm Triggers settings are the Global Alarm action rules applied to every CMP6000 

Chamber control system. 

 

Figure 3-28  Default Alarm Triggers 

To configure chamber-specific individual settings, use the Chambers Properties menu of the 

Chamber Thumbnail display. See the following section for details. 

3.3.4.2 Chamber Settings 

To change the Alarm actions of a specific Chamber:  

1. From the Central Management Main Status display window, locate the Chamber. 

2. Right-click on the Thumbnail display to bring up the Chamber menu.  

3. Select Properties (Figure 3-29). 
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Figure 3-29 Chamber Properties 

4. Select the Alarms tab.  

5. On an individual alarm, add or remove the check mark () to change the default actions 
for this number. 

The settings shown in 

 

Figure 3-30 are the alarm action rules applied to Chamber 001 of the CMP6000 Chamber control 

system. 

 

 

Figure 3-30 Chamber Alarm Settings 

The CM PC uses a built-in speaker for the audible alarm. Use the PC volume control 
to set the PC speaker volume to an appropriate volume. 

The CM PC uses a built-in speaker for the audible alarm. Use the PC volume control 
to set the PC speaker volume to an appropriate volume. 
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The settings that are grayed-out are the Global defaults that are currently applied. Overriding a 

Default Alarm action will add a check mark the “Custom” box for the row associated with the 

setting you have altered. 

 

 

Each setting can be enabled () or disabled (blank).  

1. To set the chamber to the Default Alarm Triggers settings, click Reset to Defaults. 

2. To make changes that will affect all chambers, click Edit Defaults.  
The Default Alarm Triggers Global settings window appears. 

3. To accept and activate the settings, click OK. To exit without saving changes, click 
Cancel. 

3.4 File Menu 

3.4.1 Refresh All 

To force a Thumbnail display refresh, from the Central Management menu bar, select File > 

Refresh All. 

 

Figure 3-31 Refresh All 

3.4.2 Exit 

To close the Central Management window, select File > Exit. 

 

Figure 3-32 Exit 

3.5 Help Menu 

3.5.1 Help 

To open a PDF copy of the Central Management Operators Manual, select Help > Help.  

The PDF file, which is stored in C:\Program Files\CM\Manuals\CMOperatorsManual.pdf for 32-bit 

installations and C:\Program Files (x86)\CM\Manuals\CMOperatorsManual.pdf for 64-bit 

installations, can be copied to another PC and used for reference. The PDF file is not printable. 
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Figure 3-33 Help 

3.5.2 About 

To view the technical and legal details of the Central Management software (Figure 3-35), select 

Help > About (Figure 3-34). 

 

Figure 3-34 About 

 

Figure 3-35 Technical and License Details 

3.6 Chambers Menu Properties 

To view the information of a chamber, right-click on its thumbnail display, and then select 

Properties (Figure 3-36). 
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Figure 3-36 Chamber Menu 

3.6.1 Information 

Select a tab to view or modify. The Information tab is displayed by default. All chamber 

information entered in the Edit Chambers window is displayed for the selected chamber, as seen 

in Figure 3-37 Chamber Information.  

 

Figure 3-37 Chamber Information 

Legacy chamber control systems (CMP4000 and CMP5000) will show the Alarms tab as 

disabled, as this feature is exclusive to the CMP6000 control systems. 
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3.6.2 Service History 

The Service History tab shows the current operating history of control devices in the selected 

chamber. Each chamber’s list will be different (Figure 3-38). This tab is disabled for the CMP6000 

control systems. 

 

Figure 3-38 Service History 

Items prefixed with SP are setpoints and do not have a recorded history.  

To view updated values from the chamber, click Refresh.  

To store data from the Service History tab, click Copy, and then paste the information to a 

spreadsheet or text editor. 

Service History is also available in the Web Reports. 

3.6.3 Service Notes 

Service Notes can contain any useful information, such as Maintenance, Operations journal, 

problem log, or part replacement schedules (Figure 3-39). 

 

Figure 3-39 Service Notes 
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3.6.4 Experiments 

Experiments are more than records of chamber usage (Figure 3-40). They can document the User 

or any informative notes that are pertinent to the scheduled experiment. The start and stop dates 

assist the Manager to determine the duration of all experiments. The Scheduler can print reports 

by Chamber or by User. 

 

Figure 3-40 Experiment Schedule 

3.6.5 Subscribers 

To add a subscriber, click the dropdown arrow (Figure 3-41) to display the current user list, and 

then select a user account. You can only add current users to the subscriber list. To add new or 

edit user accounts, refer to Section 3.1.4, Edit User Account, on page 30. 

 

Figure 3-41 Subscribers 
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3.7 Trend Graph 

To open the Chamber menu, right-click on its Thumbnail display (Figure 3-42). Select Trend 

Graph to plot the Chamber information. 

 

Figure 3-42 Chamber Menu 

Trend Graph will display up to 4 plots of logged data from a Chamber (Figure 3-43). Up to 365 

days in sequence may be shown on one plot. Additionally, Chamber Alarm impulses may be 

plotted on the graph. 

 

Figure 3-43 Trend Graph 

Legacy chambers may have a varied selection of logged data and logging frequency. That option 

is set at the Chamber Options screen. Note that CMP6000 control systems have a fixed logging 

frequency (18 seconds).  

To print or customize the graph, click Print or Customize. 
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3.8 Acknowledge Alarms 

To open the Chamber menu, right-click on its Thumbnail display (Figure 3-44). Select 

Acknowledge Alarms. 

 

Figure 3-44 Chamber Menu 

Acknowledging alarms indicates to the system that you have seen the alarm condition and 

subsequent action is now your responsibility. Acknowledging stops the local audible alarm and 

email notification as well as changes the state of the chamber display icons of the System tray, 

Thumbnail display, and Chambers panel. This is a chamber specific command that will only 

acknowledge alarms at the selected chamber.  

See Chapter 4, Chamber Activities, on page 53 for details on responding to Alarms. 

3.9 File Locations 

Files are stored on the local hard drive in different locations since version 7.5 of the Central 

Management systems. Both file locations are similar in structure and differ only in their “root” 

location (Figure 3-45).  

 

Figure 3-45 File Locations 
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Table 3-2 outlines the files and their locations within the Central Management system (xxx is 

Chamber ID). 

Table 3-2 CM Files and Locations 

File Location 

System files for application C:\Program Files (x86)\CM 

Application activity log files C:\Program Files (x86)\CM\ActivityLogs 

Application debuggubg*.log 
files (* not active by default 

C:\Program Files (x86)\CM\Applogs 

Log and Alarm files from 
Central Management 

C:\Program Files (x86)\CM\Chambers\xxx 

Log, Alarm, and Program 
Files from Virtual Chamber 

C:\Program Files (x86)\CM\Sites\Local 
network\xxx\Alarmlog 

C:\Program Files (x86)\CM\Sites\Local 
network\xxx\Datalog 

C:\Program Files (x86)\CM\Sites\Local network\xxx 
Programs 

 

 

 

 

Under the Sites directory is the default site name Local Network. Central Management 

automatically creates (as needed) directories for Chamber Numbers, AlarmLog, DataLog, and 

Programs. All files are text based and readable, with the exception of .CCF configuration + .CP4 

program files. These are raw Controller Files. 

 

The current 64-bit Windows installation is shown. A 32-bit system uses a similar path, 
but without (x86). 

Do not edit the CP4 or CCF files. 

This page applies to the legacy CMP4000 and 5000 control system based chambers. 
The CMP6000 based chambers save configuration files (xxxx. CCF) by default to the 
“My Documents folder”. You can save files to that location or add them to the existing 
logical CM folder structure. 
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PGM files are readable and editable versions of the CP4 files. Log and Alarm files are not 

intentionally duplicated. If Virtual Chamber is used to download Log and Alarm files from the Flash 

drive of a Chamber (optional storage) these files are stored in:  

CM\Sites\Local network\xxx\  

The file data is the same, but the latter files are branded by Central Management, with received 

time and date, automatically storing logs in the default location:  

CM\Chambers\xxx\ 

3.10 Virtual Chamber 

The Virtual Chamber option is used to communicate with the Chamber’s control system. Many 

user-level functions can be performed from this interface remotely.  

Right-click on the Chamber Thumbnail Display, and then select Virtual Chamber (Figure 3-46). 

 

Figure 3-46 Chamber Menu 

Depending on the control system type, the User interface may vary. CMP5000 and CMP4000 

series control systems use a Virtual Chamber interface (Figure 3-47).  

 

Figure 3-47 Virtual Chamber 
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The CMP6050 control system (Figure 3-48) and the CMP6060 control system (Figure 3-49) use 

the Remote Control interface. 

 

Figure 3-48 CMP6050 Remote Control 

 

Figure 3-49 CMP6060 Remote Control 

All three programs use the mouse and keyboard to make icon selections and enter information. 

The program editors have cut-and-paste editing, file import, and file export functions. Refer to 

Chapter 4, Chamber Activities, on page 53 for detailed instructions. 
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4 CHAMBER ACTIVITIES 
The Chamber Activities outlines the necessary day-to-day activities in a workflow format to aid the 

Administrator in using the software effectively.  

In this chapter, you will learn how to:  

 Work with User Types and Security  

 Set up Alarm Priorities, Procedures, and Actions  

 Plan with Experiment Scheduler  

 Operate Remote Chamber software (Virtual Chamber and Remote Control)  

4.1 User Types and Security Roles 

4.1.1 Administrator 

The Administrator has full access to the Central Management PC and can edit Chamber Lists, 

Users, Experiments, respond to alarm conditions, update service logs, and print chamber usage 

reports. They can work at the Central Management console or via Remote Desktop access. The 

Administrator typically receives global email alerts. Other users can be selected to receive global 

email alerts – there is no restriction on the number or type of user to be alerted. Two additional 

Security levels are provided – Local and Remote. The Windows and Chamber logon securities 

protect against unauthorized changes. 

4.1.2 Local Network User 

These Users may or may not have access to the Central Management PC as determined by the 

Administrator. From any network connected PC, they can use a Web Browser to connect to 

Central Management. From a Web Browser, Web Reports are presented showing a thumbnail 

display for all chambers. Users can download alarm and data files, view service history, receive 

email alarm alerts on a chamber-by-chamber basis. This requires low security, as no changes can 

be made - that is, it is a view-only mode. 

4.1.3 Remote Users 

By way of the Internet, all or part of any of the User Types can be enabled, as determined by the 

local IT security and firewall configuration rules. 
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4.2 Alarm Actions 

Central Management responds very specifically to three ranges of alarms for the CMP4000 and 

CMP5000 chambers and three client selectable actions for the CMP6000 chambers.  

4.2.1 Above Priority 40  

No Central Management response, alarm message is displayed and logged.  

4.2.2 Priority 31-40  

Audible alarm from Central Management PC 

 

 

4.2.3 Priority 21-30  

4.2.4 Email alert + Audible alarm 

 

 

4.2.5 Priority 1-20  

DCS alarm + Email alert + Audible alarm 

 

 

 

Use one of the Acknowledge Alarm buttons at the Central Management dashboard or on the 

Alarms Screen at the chamber to silence the alarm. Assess and correct the cause. 

Acknowledging, responding to, and correcting alarm conditions can prevent more 

serious problems. Alarm priorities are set first in the chambers’ Alarms screen for 

CMP4000 and CMP5000 control systems. Individual parameters can be given 

priorities in the range of 1-99. See the CMP5090 User Guide for details. Central 

Management software has an Alarm actions setting for each CMP6000 chamber to 

enable or disable the alarm actions for each alarm condition. Refer to Section 4.2 

Alarm Actions on page 54, for more information. 
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4.3 Dry Contact System (DCS) 

The DCS has two isolated sets of Form C dry contacts for alarm triggering to external systems. 

Typically, these may be an Autodialer and/or a Building Monitoring System (Figure 4-1). 

                 

Figure 4-1 DCS and Autodialer Operation 

By default, DCS automatically resets after 10 seconds, permitting retriggering of the DCS and 

Autodialer for subsequent alarms. 

The Autodialer will respond to an alarm by dialing up to four separate telephone numbers. When 

the call is answered, an Alert Condition message is delivered and a user-recordable voice 

message plays automatically.  

To acknowledge the call, press 555 on the phone keypad. 

 

A thumbnail for a particular chamber on the Central Management dashboard must be 
configured and active before the alarm can be received from that chamber. 

Chamber alarm messages are sent to Central Management when they are initially 
added to the Chamber alarm list. Existing alarm state changes are not sent to 
Central Management. Deleting the alarm from the Chamber will ensure it is reported 
to Central Management if it becomes re-activated. Central Management has an 
Alarm Delay function, which means the delay (5 seconds) is the time that an alarm 
must be present in the active state before the Dry Contacts System will be triggered. 
Version 7 of CCS added a DCS Reset Interval feature, which automatically resets 
the DCS after 10 seconds (default), permitting retriggering of the DCS for 
subsequent alarms. 
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4.3.1 Alarm States 

Normal Operation The red power LED is on to indicate the DCS box is powered. Relay 1 
and Relay 2 green LEDs are off. 

Alarm Condition Relay 1 and Relay 2 green LEDs are on and an energized relay signals 
an alarm condition. 

Power Failure Alarm If a power failure occurs at the Central Management PC, the relay will de-
energize and remain de-energized, until power comes back on and the 
Central Management operating system completes its startup sequence.  

Chamber Alarm Upon receipt of a chamber alarm of high priority (1-20), the Central 
Management will energize the relay.  

 

 

4.4 Acknowledging Alarms with DCS 

Alarm sequence 

Sequence of operation 1 During normal operation, when there are no active, 
unacknowledged alarms with a priority in the range of 1 to 20 
on the network, the NORMAL (green) LEDs are off. 

Alarm and delays 2 When an alarm occurs on any network chamber, the alarm 
delay is started. (The default delay is 5 seconds.)  

3 The audible alarm is triggered and the email alert is sent. 

4 The alarm delay lapses and the triggering of the DCS box 
occurs. The Relay 1 and Relay 2 green LEDs on the dry 
contact box comes on. The green LED lights remain on until 
the alarm is acknowledged or automatically resets after 10 
seconds. 

Acknowledging the voice warning is not the same as acknowledging the alarm. 
The Central Management alarm and autodialer voice warning must both be 
acknowledged.  

Ensure that you are attending to the alarm at the chamber that caused the dial-
out event. If you are onsite, check the Central Management dashboard or the 
chamber itself to diagnose what action needs to be taken to correct the 
problem. If you are remote, you can connect to the Central Management 
dashboard to view the alarm condition or use email alerting/web reports to 
view the actual chamber number and alarm condition. If the chamber must 
have the program settings altered, you can use the Central Management 
dashboard or personally access the chamber. 
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Autodialer 5 The autodialer input recognition delay starts (5 seconds 
default) and after the delay lapses, the autodialer will initiate 
calling the designated phone numbers (how many times it 
calls and how many numbers it calls depends on the 
programmed settings of the autodialer). 

Acknowledge 6 When the call is answered, you can acknowledge the alarm 
warning by pressing the appropriate touch tone buttons) on 
the telephone (555 is default). 

Reset 7 The “Reset DCS” button returns the dry contact box to its 
normal state. The Relay 1 and Relay 2 green LEDs will turn 
off. If another high priority alarm occurs while you are 
diagnosing and fixing the present problem, the system will be 
ready to phone out again. If this crucial step is skipped, the 
autodialer cannot be triggered to call out for the subsequent 
alarms. 

Diagnose 8 The next step is to diagnose the chamber that had the alarm 
and take the necessary steps to correct the fault.  

 

 

 

The DCS Reset interval feature automatically resets the DCS after 10 seconds by 

default, and permits retriggering of the DCS and auto dialing systems for subsequent 

alarms. If set to 0, the DCS will not reset after an alarm. To reset the alarm, use the 

Actions menu on the Central Management dashboard to force a manual Reset DCS. 

Sensaphone autodialer connected to older Central Management systems used 

a default input recognition time of 3 minutes. This is not compatible with the 

Central Management default settings. The result will be an autodialer that is 

never activated by alarms. The recommendation is to reduce the input 

recognition time to 5 seconds.  

The reason for the 3-minute input recognition time in earlier systems was to 

mask a Central Management sanity reset from alarming. While instability was 

an issue in Windows operating systems prior to Windows XP, this situation is 

very unlikely to occur with the current Central Management version. 
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4.5 Scheduling Activities 

4.5.1 Chamber Scheduler 

 

Figure 4-2 Chamber Scheduler Toolbar 

4.5.2 Save 

Save is required when changes are made. If you do not save, when you exit, changes will be lost. 

4.5.3 Show Since 

The Show Since option places the center of your scheduler view at the date you selected from 

the dropdown calendar. 

4.5.4 Time Scale 

Select View > Time Scale.  

The default settings of the time scale appear. Adjust both the bottom and middle tiers to show a 

time scale that suits your needs. 

4.5.5 Group By 

The Default View shows the Chamber ID (Figure 4-3).  

To change the grouping:  

1. Select View > Group By, and then select a new item category from the Group Items 
By list.  

2. Click OK to update your scheduler display. 

  

Figure 4-3 Default View Figure 4-4 User View 

To learn more about editing the settings of a Chamber and User Account, refer to Chapter 3, 

Using Central Management, on page 27. 
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4.5.6 Views 

The Administrator has access to two different views of the chamber information. 

4.5.7 Schedule View 

More than one experiment may be attached to a Chamber, as seen in Figure 4-3 Default View. 

However, the list of experiments may be rolled up to show only a single line per Chamber (Figure 

4-5). 

 

Figure 4-5 Timeline View 

The Schedule time line changes color to a darker shade as time progresses. The red line 

indicates the current date. 

4.5.8 Grid View 

Select the Grid View tab to customize the order of the experiment view. Click a column header to 

sort the view by its title (Figure 4-6).  

 

Figure 4-6 Grid Line View 

4.5.9 New Experiment 

On the Chamber Schedule toolbar, click New Experiment  to plan every aspect of the 

chamber’s usage. 
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The Chamber, User, Start, and End fields are mandatory and require values. However, 

additional information such as Name and Notes will assist with administration tasks (Figure 4-7). 

Experiment information appears on each Chambers’ properties menu as a tab (Figure 4-8).  

 

Figure 4-7 Experiment Info 

The experiment name is displayed on the Chamber Scheduler main window and helps 

differentiate one experiment from another. By default, lists are sorted by Chamber ID, but may be 

re-sorted by any of the displayed fields. 

There are three types of notes for each Chamber: 

 Experiment Notes—Contain experiment-related information as well as guidelines and 
warnings 

 Chamber Notes— Contain technical specifications about the chamber  

 Service Notes—Contain information for chamber maintenance 

 

Right-click on the thumbnail display of a chamber to open the Chamber menu, and then select 

Properties. 

The Chamber Information dialog box appears (Figure 4-8). 

 

Figure 4-8 Chamber Information 
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4.5.10 Reports 

1. On the Chamber Schedule toolbar (Figure 4-2), click Reports.  
The Usage Reports dialog box appears (Figure 4-9). 

 

Figure 4-9 Usage Reports 

2. Select the date period for the usage report.  

3. To view usage information by user account, click Report By User (Figure 4-10). 

 

To view usage information by chamber, click Report By Chamber (Figure 4-11). 

 

Figure 4-10 Usage Reports by User 

 

Figure 4-11 Usage Reports by Chamber 

4. Print or copy to clipboard as needed. 

4.6 Using Virtual Chamber – CMP4000-5000 Legacy 

4.6.1 Start a Virtual Session 

Depending on the type of control system used in the chamber, the interfaces may vary. The 

following information, Sections 4.6 through 4.11, refer to the CMP4000 and CMP5000 series 

control systems.  

For details regarding the CMP6000, refer to Section 4.12.  
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For details regarding the CMP6060, refer to Section 5 (Central Management uses the appropriate 

interface, according to chamber configuration, as discussed in Section 2.6, Adding a Chamber to 

the Status Display on page 19).  

From the Central Management dashboard, right-click on the chamber thumbnail, and then select 

Virtual Chamber (Figure 4-12). 

 

Figure 4-12 Chamber Menu 

 

The dialog of the selected virtual chamber appears (Figure 4-13). 

 

Figure 4-13 Virtual Chamber Display 
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4.6.2 Could Not Connect 

The following error message (Figure 4-14) may appear, indicating a complete communications 

failure. Check all settings and connections and try again. If the problem persists, refer to Chapter 

7, System Maintenance and Troubleshooting, on page 108 or call Conviron Client Services. 

 

Figure 4-14 Could Not Connect 

4.6.3 Time-out 

The following message (Figure 4-15) appears to indicate that the inactivity time-out period of 15 

minutes has expired and the Virtual Chamber has automatically disconnected from the Chamber. 

This ensures that the control system display at the Chamber is available for local access. 

 

Figure 4-15 Disconnected 

4.7 Virtual Chamber Functions 

 

 

 

 

 

Figure 4-16 Virtual Chamber Toolbar 
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4.7.1 Toolbar 

New Clears the spreadsheet 

Open Imports program (pgm) from disk 

Save Saves the current program to the Chamber 

Print Prints the current program or Chamber screens 

Cut Cuts content of selected cell(s) 

Copy Copies content of selected cell(s) 

Paste Pastes clipboard contents to selected cell(s) 

Sort Arranges rows (time lines) in chronological order 

Load Loads the current program into the Chamber Editor (ready to run) 

Sync Synchronizes the Chamber date and time to Central Management 

VC Panel Displays virtual Chamber screens of logged-in chamber 

Program Editor Edits Chamber programs on Virtual Chamber program editor 

Log files Downloads and displays alarm and data of files from Chamber storage drive 

Help Opens the Help Document VC3.pdf 

4.7.2 Menus 

4.7.2.1 File 

 

Figure 4-17 File Menu 
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The File menu contains the same functions as the icons on the toolbar, with the following 

additional functions: 

Save As Permits saving the loaded program to a different number 

Export Exports program (pgm) to Program disk 

Login Allows entering the required security information when Chamber Security is 
enabled 

4.7.2.2 Edit 

 

Figure 4-18 Edit Menu 

The Edit menu contains the same functions as the icons on the toolbar, with the following 

additional functions: 

Undo Undoes the last operation 

Delete Row(s) Deletes the selected row(s) 

Select All Selects all the cells of the spreadsheet 

Insert Row Inserts a blank row at the selected location 
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4.7.2.3 Tools 

 

Figure 4-19 Tools Menu 

The Tools menu contains the same functions as the icons on the toolbar, with the following 

additional functions: 

Upgrade For upgrading the software of the control system. Conviron is the sole 
provider of software and can add new functions to existing control systems. 

Send File Factory-only software feature 

Retrieve File Factory-only software feature 

4.7.2.4 Help 

This  icon will open the Virtual Chamber Manual in PDF format. All User Manuals are located in 

the default installation directory: 

C:\Program Files (x86)\CM\Manuals 
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4.8 Chamber Panel 

 

 

 

Figure 4-20 Virtual Chamber 

See the CMP4030 User Guide or CMP5090 User Guide for full details about the control system 

software functions and use. All the expected control system features are available at Central 

Management, using a mouse click rather than a screen touch. 

4.9 Program Editor 

To start the program editor (Figure 4-21), click Program . 

With Central Management, you can write a program, store it on the Central Management system, 

and download it to any chamber control system on the network.  

In this section, you will learn to:  

 Understand the name and function of each section of the Program Editor  

 Write programs using the Program Editor  

 Print a program from the Program Editor  

 Load programs onto a chamber control system from the Program Editor  

 Save programs onto chamber control system from the Program Editor  

 Import and Export a program into the Program Editor from Central Management  

Trendgraph 

Security 
Diagnostics Alarm 

Help 
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Figure 4-21 Program Editor 

4.9.1 Parts of the Program Editor 

No. Name Description 

1 Name list 
Lists the programs stored on the chamber control system. 
The name of the program currently loaded into the Program 
Editor is displayed. 

2 Chain list 
Lists the programs stored on the chamber control system. 
The program name displayed is the program to which the 
program currently loaded into the Program Editor is chained. 

3 Column Displays the zone currently selected in the table 

4 Units 
Displays the unit of measurement used by the current zone. 
For example: °C for temperature 

5 User Limits (Active 
Zone Operating Range) 

Displays the Chamber operating range for the active zone 

6 
Factory Limits (Active 

Zone Alarm Limit 
Range) 

Displays the range of setting for the Alarm Limits that apply to 
the active zone. You cannot change the factory settings. 

7 Program table 
A series of columns and rows in which you enter your 
program 
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4.9.2 Using the Program Editor 

4.9.2.1 Clearing the Program Table 

To clear the program table to start writing a new program, from the File menu, select New. 

 

Figure 4-22 New Program 

You can also click the New icon  on the Virtual Chamber toolbar, or press CTRL + N on your 

computer keyboard.  

If there are values in the table that have not been saved, a message appears to ask if you want to 

save changes. Click Yes to save the changes or No to discard the changes.  

The program table is cleared. 

4.9.2.2 Entering Values 

To enter a value into the program table, select a cell, and then enter a value. 

4.9.2.3 Deleting Values from Cells 

1. To clear a value from a cell or series of cells, select the cell or range of cells that you 
want to clear.  

2. From the Edit menu, select Cut. 

 

Figure 4-23 Delete 

You can also click the Cut icon  or press Ctrl + X. The selected cells are cleared and the 

values are copied to the Windows clipboard. 

4.9.2.4 Copying Values in Cells 

1. To copy a cell or range of cells, select the cell or range of cells that you want to copy.  

2. From the Edit menu, select Copy. 

 

Figure 4-24 Copy 
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You can also click the Copy icon , or on your computer keyboard, press Ctrl + C. The values of 

the selected cells are copied to the Windows clipboard. 

4.9.2.5 Pasting Values into Cells 

1. To paste values that you have cut or copied to new cells, select the cell to which you 
want to paste values.  

If you are pasting a range of cells, select the first (top, left) cell in the range.  

2. From the Edit menu, select Paste.  

 

Figure 4-25 Paste 

You can also click the Paste icon  or press Ctrl + V on your computer keyboard.  

The last value that was cut or copied is pasted to the selected cell or cells. 

4.9.2.6 Selecting the Whole Table 

You can select an entire program table, copy it, and append it to another program.  

To select the whole program table, from the Edit menu, select Select All, or on your computer 

keyboard, press Ctrl + A. 

 

Figure 4-26 Select All 

4.9.2.7 Inserting a Row 

To insert a row into the program table, select a cell in the row above where you want to insert a 

row.  

From the Edit menu, select Insert Row, or on your computer keyboard, press Ctrl + I.  

A blank row is inserted after the row you selected. 

 

Figure 4-27 Insert Row 
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4.9.2.8 Deleting a Row 

To delete an entire row, select a cell in the row that you want to delete, and then from the Edit 

menu, select Delete Row(s).  

 

Figure 4-28 Delete Row 

The entire row is deleted and the following rows are moved up in the table. 

4.9.2.9 Sorting Rows 

To sort rows by time, from the Edit menu, select Sort or click the Sort icon .  

 

Figure 4-29 Sort Rows 

The program rows are sorted chronologically. 

4.9.2.10 Undo Edit 

To undo an edit and restore the cell(s) to prior values, from the Edit menu, select Undo, or on 

your computer keyboard, press Ctrl + Z.  

 

Figure 4-30 Undo 

The value(s) are restored to the affected cell(s). 

4.9.2.11 Saving a Program to a Chamber Control System 

After writing or editing a program in the Program Editor, assign a name to the program before 

saving it. Save the program on the chamber control system before loading and running the 

program. 

To save an already named program that was just edited, from the File menu, select Save, or click 

the Save  icon, or on your computer keyboard, press Ctrl + S. 
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Figure 4-31 Save to Chamber 

To save an unnamed program that was newly created:  

1. From the File menu, select Save As (Figure 4-31), or click the Save  icon.  
The Save As dialog box appears.  

2. Enter a program number that is numeric only and is a maximum of eight characters, 
and then click OK. 

The program is saved on the chamber control system with the numeric name assigned. 

4.9.2.12 Saving a Program on Central Management 

To save a program written in the Program Editor on Central Management:  

1. From the File menu, select Export Program (Figure 4-32). 

 

Figure 4-32 Export Program 

2. In the File Name field, enter a name for the program (Figure 4-33). The program name 
can be a maximum of up to eight characters 

 

Figure 4-33 Export Program Dialog Box 
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If you want to save the program with an existing file name, select a name from the File Name list. 

Note that your changes will overwrite the old values in the selected program. 

If you want to save your file to a different directory or drive, select a new path from the Directories 

and Drives lists. 

3. Click OK. The program is saved in Central Management.  

Programs stored in Central Management have a file extension of .pgm and are text-based. They 

can be opened and edited with Excel or text editors. 

4.9.2.13 Loading a Program to the Program Screen of the Chamber Control System 

Before starting a program, first load the program into the Program screen of the control system. 

You cannot start a chamber program from the Program Editor.  

To load a program, make sure that you have saved the program on the control system as 

described in the section 4.9.2.11, Saving a Program to a Chamber Control System, on page 71. 

1. From the File menu, select Load Current Program to Chamber, or click . 
The program is loaded to the Program screen. 

 

Figure 4-34 Load to Chamber 

2. Go to the Chamber panel, and then navigate to Program Spreadsheet to run the 
program. 

4.9.2.14 Opening a Program Saved on the Central Management System 

To open a program saved on the Central Management system: 

1. From the File menu, select Import Program.  
The Import Program dialog box appears. 
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Figure 4-35 Import Program 

 

Figure 4-36 Import Program Dialog Box 

2. From the file name list, select the file that you want to open.  
 
If you do not see the file you want, select a new directory or drive from the directories 
and drives lists. 
Programs stored on the Central Management system have a file extension program. 

3. Select a file, and then click Open.  
The program you selected appears in the Program Editor. 
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4.10 Printing a Program 

To print a copy of the program that is currently loaded into the Program Editor, from the File 

menu, select Print or click . 

 

Figure 4-37 Print Program 

4.11 Log Files 

If the chamber is equipped with additional log storage, the Virtual Chamber can access, 

download, and view both Alarm and Data logs. The Virtual Chamber status bar shows if a storage 

drive is installed on a Chamber (Figure 4-38). 

 
 
 

 

Figure 4-38 Chamber Status Bar 

To access the log files on the control system, on the Virtual Chamber toolbar, click . 

4.11.1 Sync 

Before working on the files from the Chamber control system, first sync the files. In other words, 

download the files from the Chamber control system.  

1. From the Sync Files dropdown menu, select the number of days to sync data from the 
chamber to Central Management (Figure 4-39). 

Floppy Storage 

or Flash Card 
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Figure 4-39 Select Sync Duration 

2. Click the Sync Files button .  
The Virtual Chamber retrieves the files from the Chamber control system. If no file 
exists, then nothing is downloaded. 

 

Figure 4-40 Sync File Progress 

A progress indicator and file listing shows the file downloading progress (Figure 4-40). 

4.11.2 File Locations 

Central Management stores the files retrieved by Virtual Chamber on the local hard drive under: 

C:\Program Files (x86)\CM/Sites 

Inside the Sites directory is the default site named Local network.  

Inside the default site Local Network, the Virtual Chamber automatically creates (as needed) 

directories for Chamber Numbers, AlarmLog, DataLog, and Programs. All files are text-based and 
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readable, with the exception of .CP4 program files. These are raw Controller files, and the PGM 

files are the readable versions. 

 

 

Figure 4-41 File Locations 

4.11.3 View 

Once the log files are retrieved, selecting a file name in the left pane will display its contents in the 

right pane (Figure 4-42). The data view can be scrolled, sorted, and copied. If a selected file 

shows no data in the right pane, it is likely that the storage media is full and needs to be cleared. 

Do not edit the CP4 files. 

 

CMService Logs 

Virtual Chamber 

Logs 



 
 
 
 
 
Central Management Operator’s Manual Chamber Activities 

 

 

June 2018 | 283442-ENGR01  78 

 

Figure 4-42 Log File View 

4.12 Software Updates for CMP4030 and CMP5090 

Conviron can offer software upgrades to Chamber control system software to enhance the 

operation of the Chamber, add new features and change the mode of the alarming functions. 

Contact Client Services for details. 

4.12.1 Floppy vs. Flash vs. Hard Drive 

Depending on the physical characteristics, age, and versions of the hardware and software, the 

features of the CMP control systems vary. Conviron maintains detailed information that is easily 

accessed by the chamber serial number. The current features as well as the upgrade abilities can 

be determined by providing this information in any upgrade request. 

4.12.2 Prepare Package 

Conviron provides the upgrade software package on Floppy disk, Flash Card, or by way of 

electronically transferred zip file (email or the Conviron FTP site).  

For installation by Central Management or Virtual Chamber, unzip and copy the update package 

to the local hard drive. Logically if you are to upgrade Chamber 3, place the update package in a 

directory within file structure of Chamber 3 (Figure 4-43). 
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Figure 4-43 Chamber Directory 

4.12.3 Log In 

In the Central Management system, right-click on the chamber thumbnail, and then select Virtual 

Chamber (Figure 4-44). 

 

Figure 4-44 Virtual Chamber Login 

4.12.4 Security 

A minimum Security Level 40 is required for the Software Upgrade feature. This protects the 

Chamber control system from accidental corruption by unauthorized personnel. After logging in to 

the chamber, from the File menu, select Login. 

Enter a user name and password that have security level 40. 

 

Figure 4-45 Security Dialog 
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Contact your administrator or Conviron for access information. 

4.12.5 Locate Upgrade 

1. From the Tools menu, select Upgrade (Figure 4-46).  
The upgrade dialog box appears. 

 

Figure 4-46 Tools Upgrade 

2. Click Browse, and then navigate the directories to: C:\Program Files 
(x86)\CM\Chambers\003\Update 

4.12.6 Serial Number 

All Conviron products are identified by serial number; therefore, upgrades must be for the 

matching serial number. 

 

Figure 4-47 Upgrade Dialog Serial Match 

 

 
 

Once the Serial Numbers are confirmed to match, click Upgrade. The Upgrade File Transfer 

dialog box appears to show the progress of the update procedure. 

If you see the “DO NOT MATCH” message, do not continue. Cancel the 

operation, and then contact Conviron Client Services for assistance. 
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4.12.7 Reboot 

Once all the files have been transferred to the Chamber control system, a Reboot dialog box 

appears (Figure 4-48). Click Yes to restart the Chamber control system. 

 

Figure 4-48 Upgrade Complete 

Additionally, power to the chamber control system needs to be cycled off, then on again after 10 

seconds. 

The control system should restart and in a minute or two, show the status screen. If this does not 

occur as expected, repeat the power cycling and follow the recommended startup procedure for 

CMP control systems as outlined in the CMP4030 – CMP5090 User Guide or Conviron CMP4030 

Version 6.00 - 6.20 Software Update Guide. 
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5 REMOTE CONTROL 

5.1 Using Remote Control – CMP6050 

5.1.1 Introduction 

The CMP6050 is the most advanced control system developed by Conviron. Configured to your 

chamber specifications from the factory, the CMP6050 offers a wide array of setup, control, and 

alarm features to tune the configuration to your specific requirements. As well, the scalability of 

the CMP6050 accommodates additional Input/Output ports if your research requires additional 

sensors. 

 

5.1.2 Remote Control Operations 

The Remote Control Main Menu shows all of the software features (Figure 5-1). 

 

Figure 5-1 Remote Control Main Menu 

Remote Control lets you do the following tasks:  

 Connect to a chamber  

 Start and Stop a chamber schedule  

 Create, edit, or delete Programs and Schedules  

 Perform Time Synchronization  

 Modify Chamber Ramp and Step Operation  

Always keep in mind that changes made remotely to a chamber will affect its 

electrical and/or mechanical operations, even if you are not visually monitoring and 

physically present at the chamber. 

Operating the chamber remotely, while others are occupying or servicing the 

chamber, could be hazardous and may result in personal injury to service or other 

on-site personnel. As such, perform parameter changes by way of CM only if you 

are absolutely sure that no one else is occupying or servicing the chamber. 
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5.1.3 Chamber Communication 

5.1.3.1 Addressing 

5.1.3.1.1 TCP/IP 

All Chamber settings are done in the CMP6050 Options screen. 

5.1.3.1.2 SNMP 

Port 161 is the standard SNMP port. This port is not alterable. 

5.1.4 Remote Access 

5.1.5 Firewall 

Windows or third-party firewall software must allow the SNMP port (161) to pass through from the 

Chamber to the Central Management and/or Remote Control software. 

5.1.6 Chamber Information 

When connected to a Chamber, the Chamber information is displayed in the status bar of the 

Remote Control dialog box (Figure 5-2). 

 

Figure 5-2 Remote Control Status Bar 

Connection status, Chamber serial number, control system version, and remote control software 

version are displayed. Access to the CMP6050 control system is by way of Central Management. 

5.1.7 Connecting to Chambers 

To connect to a chamber, right-click on the Chamber thumbnail on the Central Management 

status window, and then select Virtual Chamber. 
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Once you are connected to a chamber, the Remote Control main menu appears (Figure 5-3). 

 

Figure 5-3 Remote Control Main Menu 

 

5.1.8 Disconnect 

Click the Exit icon  to terminate an active connection. The Remote Control software detects 

inactivity, and after 15 minutes, automatically terminates an active connection, releasing the 

Chamber display lockout after a few seconds. 

5.1.9 Chamber Status 

5.1.9.1 Starting and Stopping 

Once you have connected to a chamber, the status of both the Chamber and the schedule is 

indicated in the Chamber Status section (Figure 5-4). 

 

Figure 5-4 Chamber Status 

If the Chamber is running, the Start icon is disabled and the Stop icon is active, indicating that 

you can stop the Chamber at any time. 

When the Chamber is stopped, the Start icon becomes active.  

When the Start icon is selected, you are prompted to pick a program to run from the schedule. 

During a Remote Control session, the Chamber display is locked from local use. This 
ensures that only one user at a time has access to the chamber. 
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5.1.10 Programming 

5.1.10.1 Creating a Program 

1. Click the Create icon  to start creating a program.  
In the Program ID field, the next unused program number becomes available (Figure 
5-5).  

 

Figure 5-5 Program Selector 

2. Click Select to accept the new number or use the spinner to choose another number, 
with only the unused number displayed.  
The Program Spreadsheet appears. 

3. Use the Program Spreadsheet Tools to insert timelines specific to your needs.  

For more information, refer to Section 5.1.10.2, Editing a Program, on page 86. 

5.1.10.1.1 Program Spreadsheet Tools 

 

Figure 5-6 Program Spreadsheet Tools 

Click To 

Insert Line Insert a time line with default settings. 

Duplicate Line Insert a copy of an existing line. 

Delete Line Remove the selected line or lines from the program. 

Sort Lines Arrange the lines in ascending or descending order, according to the 
selected column header. 

Graph Display data graphically. Highlight one or more columns by selecting 
the column header with a right-click, and then click Graph. 

Upload Program Save the new or edited program to the Chamber control system 

Close Close the Program Spreadsheet window. Unsaved changes are lost. 
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5.1.10.2 Editing a Program 

1. Click the Edit icon  to start the editing a program.  

2. Click Select to accept or use the spinner to choose another number. Only used 
program IDs will be displayed.  
The Program Spreadsheet toolbar becomes active.  

3. To insert a time line with default settings, click Insert Line.  

4. To sort the lines by column header, select Sort Lines, and then click a column header 
to arrange the lines in ascending or descending order, according to the selected 
column. 

5. To view data graphically, click Graph . 

Programmed parameters can be easily verified by highlighting one or more columns with a right-

click. The column header changes color to indicate selection. 

 

 

Figure 5-7 Program Verification 

6. Click Upload Program to save the current spreadsheet program to the chamber. 
Otherwise, click Close to exit the window and lose unsaved changes.  

Before you can run the program, first add it to a Schedule. Refer to Section 5.1.11.1, Creating, 

Editing, or Deleting a Schedule, on page 87 for complete details. 

5.1.10.3 Deleting a program 

The Program Spreadsheet toolbar becomes activated. 

Click To 

Delete Program Delete the currently selected program 

Close Quit the Program. Unsaved changes are lost. 
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5.1.11 Scheduling 

5.1.11.1 Creating, Editing, or Deleting a Schedule 

 

5.1.11.2 Schedule Table Tools 

Click To 

Insert Entry Add a line to the schedule table. Entries of program number and 
program repeats are defaulted to 1, but you can change the value, 
as necessary. 

Delete Entry Remove a program from the schedule table 

Program repeat To set the program to repeat between 1 and 99 repetitions 

Global repeat May be set between 1 and 99 or infinite / continuous repetitions of 
the schedule 

∞ Select the infinity symbol to set the Global Repeat to continuous. 

Upload Schedule Send the schedule to the chamber. 

Close Close the Schedule window. Unsaved changes are lost. 

 

5.1.11.3 Working with the Schedule Editor 

The Schedule section in the Remote Control main menu lets you create, edit, or delete a 

schedule (Figure 5-8). 

 

Figure 5-8 Schedule Section in the Remote Control Main Menu 

Creating a schedule is only allowed if there is no existing schedule. Once the 

schedule is created, the Delete button becomes activated.  

Editing a schedule requires an existing schedule.  

Deleting a schedule is only allowed if there is an existing schedule. Once the 

schedule is deleted, the Create button becomes activated. 
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When you select one of the Schedule icons, the Schedule Editor dialog box appears (Figure 

5-9). 

 

Figure 5-9 Schedule Editor 

To create or edit a Schedule, do the following: 

1. To open the Schedule Editor dialog box, click the Create or Edit icon. 

2. Add or modify the schedule entries for programs and repetitions. 

3. Set a value in the Global Repeat field. 

4. To save the schedule, click Upload Schedule into Chamber.   
 
If you click Close without uploading the schedule into the chamber, then Schedule 
Editor discards any changes. 

5. To run the schedule, select the Start icon , and then select a program (row) to be 
the first program to run (Figure 5-10). 

 

Figure 5-10 Start Schedule 
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5.1.12 Time Synchronization 

Click the Time Synchronization icon  to set the control system to the same time and date as 

Central Management. 

The SYNCHRONIZE TIME dialog box appears (Figure 5-11). 

 

Figure 5-11 Time Synchronization 

 

5.1.13 Ramp-Step Mode Setting (Prior to Version 3.10) 

Previous versions of the CMP6050 software allowed Step or Ramp Mode control for temperature, 

and Step Mode only for all other processes. 

1. Click the Ramp/Step icon  to open the Ramp/Step Settings dialog box (Figure 
5-12). 

 

Figure 5-12 Ramp/Step Settings Software versions prior to v3.10 

If you select Step, then the Speed field is disabled. 

The permissible setting range is from 4 to 900 minutes per degree Celsius. Attempting to set 

beyond this range will cause a warning dialog to be displayed. 

2. Click Save to save the settings and immediately update the chamber control system.  

To discard the changes and exit, click Close. 

Altering the control system time and date will cause changes to the logged data 
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When the mode is changed, the Chamber confirms the setting (Figure 5-13). 

 

Figure 5-13 Change Mode 

5.1.14 Revised Process Ramping (for Version 3.10) 

The CMP6050 control system version 3.10 lets you select Step mode, Ramp mode, or Disable 

mode for all process controls (Figure 5-14). The various modes can be changed while a program 

is running. Note that all processes can be disabled, except temperature. 

 

Figure 5-14 Ramp/Step Setting Software v3.10 and later 

1. Select Ramp, Step, or Disable for any of the processes of the dialog.  

2. Click OK to save the settings and immediately update the chamber control system.  

To discard the changes and exit, click Cancel. 

When the mode is changed, the Chamber confirms the setting (Figure 5-13). 

5.1.15 Security and Login 

The security settings are entirely based in the Chamber control system. This permits individual 

Chamber settings. 

5.1.15.1 Security and Login Screen 

If the security features are enabled at the Chamber control system, then a single prompt for 

password appears when a user logs in to the Chamber. The password entered is validated by the 

chamber and access is granted if the password matches the Chamber settings. 
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5.1.15.2 Logout Security Screen 

When the Remote Control program is terminated, you are automatically logged out of the 

Chamber after a few seconds. 

5.2 Using Remote Control – CMP6060 

The CMP6060 Remote Control is an exact mirror of the local chamber display. Actions taken on 

the Remote Control are reflected on the local display and vice versa. The CMP6060 Remote 

Control is a perfect tool for local display training without being at the chamber. It allows full access 

to the chamber controls, settings, and parameters (with a few minor exceptions described in the 

following sections). It is ideal for monitoring local operation or local maintenance and 

troubleshooting. 

5.2.1 Chamber Communication 

5.2.1.1 Addressing TCP/IP 

Use the Options screen to customize the Chamber settings, as described in Section 2.2.5, 

CMP6060 Networking, on page 14. The IP address of the display also has to be entered in the 

Edit Chamber dialog box as described in Section 2.6, Adding a Chamber to the Status Display, 

on page 19, in the HMI Address Column, or in the Chamber Information dialog box as described 

in Section 3.6, Chambers Menu Properties, on page 44. 

5.2.1.2 Port 

Port 5900 is the standard Remote Control port. This port is not alterable. 

5.2.2 Remote Access 

5.2.2.1 Firewall 

Windows or third party firewall software must allow the Remote Control port (5900) to pass 

through from the Chamber to the Central Management and / or Remote Control software. 
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5.2.2.2 Connecting to Chambers 

To connect to a chamber, on the Central Management dashboard, right-click on the chamber 

thumbnail, and then select Virtual Chamber. 

 

Once you are connected to a chamber, the Remote Control main menu appears on the computer 

screen (Figure 5-15).  

 

Figure 5-15 Remote Control Window 

The chamber thumbnail also displays a Connected status (Figure 5-16). 

 

Figure 5-16 Chamber Thumbnail with Virtual Chamber Connected 

 

During a Remote Control session, the Chamber Touch screen mirrors identically the 
remote HMI and both the local user and the remote user can interact with the display 
and observe the actions on the display. 
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5.2.3 Disconnect 

Click the Exit icon  to terminate an active connection. The Remote Control software detects 

inactivity, and after 15 minutes, automatically terminates an active connection, releasing the 

Chamber display lockout after a few seconds. 

5.2.4 Remote Control Function 

The remote control mirrors the local interface. Refer to the CMP6060 Operator’s Manual for 

instructions about operating the control system. The remote control interface allows the use of the 

mouse and keyboard on the Central Management computer. When a keypad is displayed on the 

computer screen, use the CM keyboard to enter information.  

The following functions are not available from the remote connection (and locked out from the 

local display as well when a remote connection is in progress):: 

 HMI display IP address modification (because changing the HMI display IP address 
could terminate the remote control session) 

 Overriding output values in the Service screen. For safety reasons, output values may 
not be overwritten from the remote control interface, as there is a risk of personnel 
working or servicing the chamber while the remote connection is active, and energizing 
the equipment remotely could harm people working in the chamber. 
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6 REMOTE CHAMBER PROGRAMMING 
The Remote Chamber Programming allows the user to work with the Chamber from offsite 

locations using remote communication technologies. 

In this chapter, you will learn how to: 

 Add Subscribers. 

 Receive and use Email Alerts. 

 Use Web Reports to view Chamber history. 

 Connect to Central Management through Microsoft Remote Desktop or an alternate 
remote control program, such as TeamViewer™. 

6.1 Email Alerts 

This section covers the Email Alert message and its features. The configuration details of the 

Central Management Email settings are covered in Chapter 7, System Maintenance and 

Troubleshooting, on page 108. 

 

6.1.1 Alerts for Subscribers 

There are two types of Subscribers for Email Alerts. 

 Network Subscriber – Receives Global Email Alerts from all Chambers on the network 

 Chamber Subscriber – Receives Email Alerts only for the chambers for which the user 
has subscribed (Figure 6-1) 

 

Figure 6-1 User Creation 

Before creating subscribers, first ensure that they are already added as Users into Central 

Management system. Names and valid email addresses are required. Once an account is in the 

User list, the account can be attached to a particular chamber subscriber list or added to the 

network subscribers list. 

All of the features in this Chapter require configuration by an onsite IT personnel. 
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6.1.2 Add Subscriber 

To add a Chamber Subscriber to a particular chamber: 

1. On the Central Management dashboard, right-click the thumbnail of a Chamber.  
The Chamber menu appears (Figure 6-2). 

 

Figure 6-2 Chamber Menu 

2. Select Properties. 

3. On the Properties dialog box, select the Subscriber tab.  

4. Click on the drop-down menu to display the current user list, as seen in Figure 6-3. 

 

Figure 6-3 Chamber Subscriber 

5. Select a user, and then click OK. 

You can add one or more users to the subscriber list.  

All users will receive an Email Alert when an alarm condition at this chamber is triggered that 

meets the Email Alert configuration. 
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To add a Network Subscriber to Global Email Alerts, from the Central Management menu bar, 

select Tools > Network Subscribers (Figure 6-4). 

 

 

Figure 6-4 Network Subscriber 

A subscriber list may have one or more network subscribers. All subscribers on the list will receive 

an Email Alert in the event of an alarm condition at any network Chamber that meets the 

configured Email Alert settings. Subscribers who are listed on both Network and Chamber lists will 

receive only a single Email Alert. 

6.1.3 Alert Message 

The email message of an Alarm contains: 

 when the alarm occurred, 

 what the priority was, and 

 a text description of the alarm condition. 
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The Chamber uses abbreviations in the description, which are easily understood. From an alert 

message (Figure 6-5), check the description line for the Alarm Description.  

 

Figure 6-5 Alert Email Message 

The Web Report link opens a Web page showing detailed information about the alarm. 

6.2 Web Reports 

6.2.1 Status 

 

Figure 6-6 Web Report 

 

 

Alarm Description 

Web Report Link 

Folder 

panel 

Network 

status 

Thumbnail Status Displays 
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6.2.2 Chamber Page 

To access a Chamber page, select the chamber ID number.  

The Chamber page (Figure 6-7) shows the current alarm status as well as five different links to 

allow access to additional information pages. Each page lets you select a particular time range for 

the displayed data. 

 

Figure 6-7 Email Alert Link Page 

Chamber ID Alarm Status 

Setpoint 

Actual 
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6.2.3 Alarm History 

On the Chamber page, select the Alarm History link, specify the date to display, and then click 

Show. 

 

Figure 6-8 Alarm History 

6.2.4 Log History 

On the Chamber page, select the Log History link, and then specify the date to display. 

If you want to display the alarms, select Show Alarms, and then click Show. 

 

Figure 6-9 Log History 
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6.2.5 Trend Graph 

On the Chamber page, select the Trend Graph link, and then specify the date and number of 

days to display. Select the data fields to graph from the list boxes, and then click Show.  

You can also select Show Alarms to view the alarm time indicators. 

 

Figure 6-10 Trend Graph 
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6.2.6 Service History 

On the Chamber page, select the Service History link to show the current time-on or cycles of 

each output. These values can only be changed at the Chamber’s local display screen and only 

for CMP4000-5000. 

 

Figure 6-11 Service History 

6.2.7 Download Data 

To download Chamber logged information (whether alarm or data logs), do the following: 

1. On the Chamber page, select the Download Data link.  
The Download Data page appears (Figure 6-12). 

 

Figure 6-12 Download Data 

2. Select the Start Date, End Date, the type of data to download, and the file format.  
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3. Click Download.  
A message appears prompting you to open or save the file (Figure 6-13). 

 

Figure 6-13 Open/Save Download 

6.3 Remote Desktop 

 

 

This instruction is based on Microsoft Windows 7 Professional. Other Windows 
interfaces differ slightly. 

Central Management is normally the connection point to several external alarm 
monitoring systems. Consequently, it is important to understand the following: 

 If a procedure requires rebooting or shutting down the equipment, the 

onsite authority must first be informed before proceeding with the reboot 

or shutdown tasks. 

 Be certain of the correct procedures for remote connection, login, and 

disconnect. If you select the incorrect “quit” methodology, you could shut 

down the CM system rather than simply disconnecting the remote 

connection. If the system is shutdown, no subsequent chamber alarms 

occurring would be recognized by CM, thereby failing to send out alarm 

notifications. Once shutdown, the CM system would require a manual 

startup.  

 The CM system shows many of the parameters of the chamber; however, 

the alarm settings and physical conditions are not available to the remote 

user. Any type of change or diagnostics is best performed when onsite 

personnel are available to work with the remote user. 
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Central Management can be accessed through generic Windows Terminal Services or Microsoft 

Windows Mobile 2003SE for PDAs. 

6.3.1 Logon Security 

By default, the Central Management systems have the Remote Desktop connection enabled. 

Typically, only the Administration account conviron is permitted to gain control of the Central 

Management computer. 

6.3.2 Install Defaults 

The login and password is unique for each Central Management system and is documented in the 

Central Management Installation Manual delivered with the product shipment. If this information is 

lost, please contact Conviron Client Services, with your Central Management serial number, which 

is located on the Central Management PC side panel (Figure 6-14).  

 

Figure 6-14 Serial Card 

6.3.3 Single User 

Microsoft Remote Desktop protocol (3389) can be used to do a Central Management takeover. 

Microsoft XP Professional software allows a single login session at any time. When the remote 

desktop session is active, the Central Management console cannot be used without disconnecting 

the remote user. Conversely, locally logging on to the Central Management system during a 

remote session will disconnect the remote user. 

 

 

When a user is disconnected, their programs are closed and unsaved data may be 
lost. 
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6.3.4 Start 

To connect to the Conviron Central Management Server, open your Remote Desktop program: 

1. On your computer, click Start > All Programs > Accessories > Communications > 
Remote Desktop Connection.  
The Remote Desktop Connection dialog box appears (Figure 6-15). 

 

Figure 6-15 Remote Desktop Connection 

2. In the Computer field, enter the TCPIP address of the Conviron Central Management 
Server, using the address provided by your onsite IT staff. 

This will likely be the TCPIP address of a firewall or the Central Management system Building 

Connection address. 

3. Click Options. 

6.3.5 Options 

Review the settings under each tab (Figure 6-16) to set the preferred parameters for your 

connection and graphics needs. To share drives and clipboard with the remote Central 

Management system, configure the related options. 

 

Figure 6-16 Remote Desktop - Options 
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6.3.6 Display 

The default display setting (Figure 6-17) is suitable for most situations. 

 

Figure 6-17 Remote Desktop - Display Settings 

6.3.7 Local Resources 

Click More to show the drive list (Figure 6-18).  

  

Figure 6-18 Remote Desktop - Sound and Drive Mapping 

Selecting a drive letter enables disk drives to be available to transfer local files to and from 

programs on the Central Management Server. Improved performance will be achieved if these 

options are disabled. Selecting printers allows your local attached printer to be available on the 

Central Management server programs. Printer driver installation may be required, depending on 

printer requirements. Select Clipboard to allow the cut-and-paste function between the Central 

Management system and remote computer. 
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6.3.8 Experience 

In the Experience tab, set the performance option of your connection speed. If you clear the 

checkboxes of the features, the performance of the display increases, but the quality of the 

Central Management screen decreases. 

 

Figure 6-19 Remote Desktop Experience 

6.3.9 Save Defaults 

Once the settings are configured, select the General tab, and then click Save to save your 

settings for future connections (Figure 6-20). 

 

Figure 6-20 Remote Desktop - Save Settings - Connect 

Ensure that you have an active Internet connection, and then click Connect to log in to the remote 

desktop. 
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6.3.10 Logging In 

A dialog box appears, prompting you for a username and password.  

Contact Conviron Client Services if you have lost this information. Be prepared to provide the 

Central Management system serial number. 

Once you are connected, the Central Management desktop appears. 

When your session is complete, click Log Off to close the programs and close the remote 

session. The Central Management programs run as Windows Services and will run as long as the 

Central Management computer is powered on. 
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7 SYSTEM MAINTENANCE AND TROUBLESHOOTING 
The Central Management system settings, Chamber configuration, Operating System, and the 

Client PC settings are all important to ensure systems communicate properly (Figure 7-1). 

 

Figure 7-1 Ethernet Connections 

 

In this chapter, you will learn how to: 

 Connect hardware components 

 Check all system settings - Central Management, Firewall, Chamber 

 Test functionality of devices 

 Perform basic troubleshooting 

 Configure software features 

 Set up the Central Management Backup 

 Run DVD Restore system 

 Update DVD Restore 

 Install Central Management Software-only 
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7.1 Connection Procedure 

1. Connect the Cabling to the Chamber.  

2. Connect Devices to the Network Switch.  

3. Connect Central Management.  

4. Set the TCP/IP Addressing of Central Management.  

5. Set the Chamber ID (TCPIP) Addressing.  

6. Verify and Test Communications. 

 

 

7.1.1 Cable 

Ethernet Straight-through cables are normally connected to the network Switch (or Hub) and to 

each device. 

If no switch is involved, an Ethernet Crossover cable is connected directly from the Chamber to 

the PC (Figure 7-2). 

 

Figure 7-2 Ethernet Crossover Cable 

Follow the connection procedure, ensuring all devices are connected before applying 
power. 
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7.1.1.1 Chamber 

Connecting the cabling to the Chamber, the Central Management network uses UTP (Unshielded 

Twisted Pair) 100Base-T Category 5E, Ethernet cabling. From the Chamber, the cable exits the 

control panel and lays in a series of J hooks crossing the ceiling/wall. The J hooks (Figure 7-3) are 

spaced on a maximum of 5-foot centers and bring each cable run in an organized fashion from the 

devices (Chamber and PC) to the location of the switch(es). 

 

Figure 7-3 J-Hook Cable Supports 

Before making any connections to the Chamber control system, first ensure that the control 

system is powered off. 

Connect an Ethernet cable to the Chamber. The cable is connected to an RJ-45 receptacle on the 

bottom plate of the chamber control system or at the top of the Control Panel (Figure 7-4 and 

Figure 7-5). 

 

Figure 7-4 CMP4000-CMP5000 Bottom Ethernet 
Connection 

 

Figure 7-5 CMP6000 Ethernet Socket 
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7.1.1.2 Switch 

The switches or hubs provide multiple ports that are wired with Ethernet UTP cables connecting 

each chamber to Central Management. There is one cable for each device, and each port has the 

same function (Figure 7-6). 

 

Figure 7-6 Network Switch 

7.1.1.3 PC 

7.1.1.3.1 Connecting the PC (Central Management) 

Connect the Chamber and Central Management PC to the Ethernet switch using the same 

ethernet cabling as the Chamber. The correct network adapter to connect to the chambers is 

labeled Chamber network (Figure 7-7). 

 

Figure 7-7 Central Management PC Connections 

The Building Network connection is optional and must be configured by onsite IT staff. 

Display 

Keyboard 
Mouse 

DCS 

Chamber 
Network 

Building 
Network 
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7.1.1.3.2 Checking the Addressing of the Central Management 

The Central Management system is installed with 192.168.0.100 (netmask 255.255.255.0) as the 

default network address. Chambers also default to 192.168.x.xx for Central Management 

Network, but their address must be set, so each chamber has a unique ID (address). 

Assuming the first chamber is set to 192.168.0.1 (Unit ID 001), set each chamber to have 

sequential IDs (1,2,3 ...and so on). Conviron has reserved the first (100) addresses for legacy 

chambers, CMP4000 and CMP5000. The remaining addresses of 192.168.0.101 to 254 are 

suitable for selection for CMP6050 chamber control systems. 

The standard configuration of the chamber control systems prior to CCS v7 used different TCP/IP 

addresses. New chambers use 192.168.x.xx by default. Legacy chamber configurations must be 

updated to enable communication to the new Central Management address. 

 

7.1.1.4 Chamber address 

7.1.1.4.1 Setting Addresses for CMP4000 and CMP5000 

1. Power on the Chamber control system.  

2. Once you see the chamber status screen, tap the Options icon  and locate the 
Group and Unit numbers.  

3. Tap the group and unit buttons to set the control systems Group to 0 and Unit ID to 1-
99 or the desired TCP/IP address.  

4. Once the Group and Unit are set, tap Exit  to save and exit. A pop-up window 
appears, warning “Net Address changed you must cycle power.” 

5. Tap OK to proceed.  
After restarting, the new Unit ID appears on the control system status display (Figure 
7-8). 

Updates must be done with the assistance of Conviron Client Services. 
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Figure 7-8 CMP5090 Status Display 

When the Status screen is viewed, communication between the Chamber and Central 

Management should be completely functional. 

 

 

Addressing format requirements: 

 IP address is 192.168.x.yy 

 x is the first digit of the LCS. Range is 0 to 9 

 yy are the last two digits of the ID. Range is 1 to 99 

 Subnet mask is fixed at 255.255.255.0 
 

Setting the Unit ID to 001 will set the TCP/IP address of the chamber to 

192.168.0.1. 

Remember, the chamber must be set to an address in the same network (x) as the 

Central Management™ PC (default - 192.168.0.100). 
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7.1.1.4.2 Setting Addresses for CMP6000 

The CMP6050 series can be connected to a Central Management system on an Ethernet Local 

Area Network. To enable communications the control system must be connected to the network 

and configured with a suitable network address. There are two network addresses to set up in the 

CMP6050 series as follows: 

CMP Address Address or ID of the control system within the network 

Netmask 
Divides an IP address into subnets and specifies the network’s 
available host 

Central Management Enables or disables CM communication 

CM Address Central Management IP Address 

 

 

To set the Chamber Addressing: 

1. From the status screen, tap the ID button  to access the network configuration 
(Figure 7-9). 

 

Figure 7-9 Network Configuration 

 

A valid IP address is needed for the CM Address value even if there is no Central 

Management system present. 

If “Disabled” is displayed, select the Disabled text and use the controller keys (Figure 

7-10) to change the value to Enabled. Press Enter to save. 



 
 
 
 
 

Central Management Operator’s Manual System Maintenance and Troubleshooting 

 

 

June 2018 | 283442-ENGR01  115 

 

Figure 7-10 Controller Keys 

2. To change the address numbers, touch each individual numerical field. A pop-up 
keypad (Figure 7-11) appears each time a field is accessed. 

 

Figure 7-11 Keypad 

3. Once all the addresses have been entered, tap the Exit button . A pop-up warning 
window (Figure 7-12) appears to confirm the numerical entries. 

 

Figure 7-12 Save Network Changes 

4. Tap Yes to save the changes or No to discard the changes. Tap Cancel to return to the 
previous screen and reenter any numerical address errors. 
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7.1.1.4.3 Setting Addresses for CMP6060 

The CMP6060 can be connected to the Central Management system on an Ethernet local Area 

network. To enable communications the control system and the Display must be connected to the 

network and configured with a suitable network address. There are two places where the control 

system and Display IP addresses must be set-up: At the control system/Display and at the Central 

Management PC. 

There are three network addresses to set in the CMP6060: 

Control System Address Address or ID of the control system within the network 

Netmask 
Divides an IP address into subnets and specifies the network’s 

available host 

Display Address Address or ID of the HMI Display within the network 

Netmask 
Divides an IP address into subnets and specifies the network’s 

available host 

Central Management Enables or disables CM communication 

CM Address Central Management IP Address 

 

 

A valid IP address is needed for the CM Address value when there is a Central 

Management system present.  

If there is no Central Management system present, then the CM Address should be 

set to Disabled. 



 
 
 
 
 

Central Management Operator’s Manual System Maintenance and Troubleshooting 

 

 

June 2018 | 283442-ENGR01  117 

To set the Chamber Addressing: 

1. From any screen, touch the ID button in the top banner to access the network 
configuration (Figure 7-13). 

 

Figure 7-13 CMP6060 Network Configuration 

2. Tap on any of the values to bring up a dialog box to edit the settings. There are two 
dialog boxes: one for the HMI settings (Figure 7-14) and one for the PLC/CM Settings 
(Figure 7-15).  

3. Tap on any of the values to bring up a keypad, and then enter the new values.  

 

 

 

Figure 7-14 HMI Network Settings 

 

Figure 7-15 PLC and CM Network Settings 

4. Tap Enable/Disable CM to toggle between enabling and disabling CM. 

The HMI Network setting dialog cannot be canceled and will reboot the HMI once the 

Apply button is tapped. 
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7.1.2 Test Communications with Central Management 

When the chamber control system boots up, it senses the cable connection to the switch and to 

the Central Management system. If the connections are in place and configured correctly, the 

control system signals Central Management and a socket connection (software communication) is 

established. Through this socket, the chamber information is sent to Central Management. The 

most obvious indicator of the communication is the Chamber Status Thumbnail on Central 

Management (Figure 7-16).  

1. To start Central Management, double-click on the Central Management icon. If the unit 
ID of your chamber does not appear on the All Chambers section, then select Edit 
Chambers to add a new display. Grayed-out displays are not communicating between 
Central Management and the Chamber. Chamber thumbnail displays typically appear 
when a chamber is powered on. After a PC power on, thumbnail displays may take up 
to 15 minutes to appear.  

2. To verify communications to the chamber, a virtual login can be attempted at any time. 
Right-click on a thumbnail display, and then select Virtual Chamber. 

 

Figure 7-16 Central Management Status Thumbnails 
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The following window (Figure 7-17) appears as communications initiate with the chamber. 

Normally this proceeds rapidly. Within seconds, the Virtual Login will open to the chamber status 

screen.  

 

Figure 7-17 Connecting 

One of the following Virtual Chamber Status screens appears, indicating the connection is 

successful: Figure 7-18, Figure 7-19, or Figure 7-20.  

 

Figure 7-18 Virtual Chamber for CMP5090 

 
 

 

Figure 7-19 Virtual Chamber for CMP6050 
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Figure 7-20 Virtual Chamber for CMP6060 

If none of the screens appears, an error message will be displayed. 

The error messages (Figure 7-21 and Figure 7-22) indicate a communications failure. Refer to 

Section 7.2, Diagnostics Switch, on page 120 to check all settings and connections, and then 

retest. If the problem persists, seek Conviron Technical assistance. 

 

Figure 7-21 Login Failure - CMP5090 

 

Figure 7-22 Login Failure - CMP6050 

7.2 Diagnostics Switch 

The switch has indicators that will assist in determining if connections and communications are 

operational (Figure 7-23). 
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Figure 7-23 Network Switch 

Link/Act This indicator lights up when the port is connected to an Ethernet 
device; if the light is blinking, it indicates that data is being transmitted 
or received. 

Power The Power indicator light is green when the switch is receiving power; 
otherwise, the light is off. 

FDX/Col (Full-

duplex/Collision) 
This LED indicator light is green when a respective port is in full duplex 
(FDX) operation mode. Otherwise, it is blinking when collisions are 
occurring on the respective port in half duplex operation mode. 

100Mbps This LED indicator lights green when the port is connected to a 
100Mbps Fast Ethernet station. Otherwise, the LED is off when the 
port is connected to a 10Mbps Ethernet device. 

 

 
 

 

The Link light must be illuminated for any device connected to the switch, when 
the devices (control system or PC) are powered on. 

If not, check the device connected to that port. Reasons may include: 

 The cable may be disconnected. 

 The cable may be defective. 

 The device address may be unset. 

 The device may need a reboot. 

If the Chamber control system is powered on and the green Ethernet Network 
Indicator is off, check the following: 

 Cable is connected. 

 Address is set. 

 Reboot the control system. 

 If it is a software problem, then reload the software. 

 If it is a hardware problem, then replace the Controller. 
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7.2.1 Chamber 

On the rear panel of the Chamber control system are several indicators for diagnostics (Figure 

7-24). The green Ethernet Network Link Indicator must be constantly illuminated for Network 

communications to be functional. The red Ethernet Activity Indicator will flash intermittently when 

information is being transferred, such as during a Ping test.  

 

Figure 7-24 CMP5090 Indicator LEDs 

7.2.2 Central Management 

 

Figure 7-25 PC Ethernet Connector 

The PC Ethernet Connector shows a steady green light, indicating good link between the Network 

Card and the switch. A flashing green light indicates activity (transmitting or receiving) within the 

adapter. 

 Full – Steady green indicates the adapter is operating in full-duplex mode. 

 1000M – The LED indicator lights green when a 1000 Mbps device is connected to the 
adapter. 

 100M – The LED indicator lights green when a 100 Mbps device is connected to the 
adapter. 

If all the above checks were accomplished and still no Thumbnail Display activity is seen: 

 Try a Virtual Login to the Chamber 

 In a Command window, run a Ping test. See the following section for complete details. 
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7.2.3 Network Ping 

The Ping utility is essentially a system administrator’s tool used to check if a computer is operating 

and network connections are intact. 

A small packet is sent through the network to a particular IP address. 

The computer sening the packet then waits (or listens) for a return packet. 

If the connections are good and the target computer is up, a good return packet will be received. 

The Ping command also lets you know the amount of time it takes for a packet to make the 

complete trip. 

One address that cannot be used by any computer in the world, is the address 127.0.0.1. This 

address has been reserved for what is known as the loopback address. A loopback address is an 

address that tells the computer to test its own basic network setup. 

 

If the CM is powered on and the green Ethernet Network Indicator is off, check 
the following: 

 Cable is connected 

 Address is set 

 NIC is Enabled 

 In a Command window, enter ping 127.0.0.1. If there is a time-out or 

error message, then it is a software problem. 

 If it is a hardware problem, then replace the NIC. 

For hardware problems with PCs under Conviron warranty, contact Conviron 
Client Services. For software issues, the re-installation of a device, driver, or 
program will correct most problems. The Central Management system can be 
restored to factory conditions using the Restore feature as a final solution. 

All Conviron units by default use the prefix 192.168 (custom or versions prior to V7 

may have a different default prefix). 
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7.2.3.1 Using Ping to Test the Network Connection 

1. Open a Command Prompt window and at the prompt (C:\), type the command line as 
shown, using the Unit ID number of the control system as the internet address. Note 
that all Conviron chambers use the prefix 192.168.  

2. On the computer keyboard, press Ctrl+C to stop, and record minimum, maximum, and 
average ping times. 

Usage: ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS] [-r count] [-s count] [[-j host-list] | [-k 

host-list]] [-w timeout] destination-list 

Examples 

Table 7-1 Ping Command Options 

To test chamber 001 use ping 192.168.0.1 

To test chamber 101 use ping 192.168.0.101 

 

Usage: ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS] [-r count] [-s count] [[-j host-list] | [-k 

host-list]] [-w timeout] destination-list 

Option Description 

-t Ping the specified host until stopped. 

 To see statistics and continue, type Ctrl – Break. 

 To stop, type Ctrl – C. 

-a Resolve addresses to hostnames. 

-n count Number of echo requests to send 

-l size Send buffer size. 

-f Set do not Fragment flag in packet. 

-i TTL Time To Live 

-v TOS Type Of Service 

-r count Record route for count hops. 

-s count Timestamp for count hops 

-j host-list Loose source route along host-list 

-k host-list Strict source route along host-list 

-w timeout Timeout in milliseconds to wait for each reply 
 

 

If the basic communication problem persists, consult local IT staff or call 

Conviron Client Services for technical assistance. 
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7.3 Central Management and Chamber Networking 

In all Windows-based Computer Operating Systems, a network adapter will require a TCP/IP 

address to operate on the LAN. Conviron Software expects at least one adapter in the PC to be 

dedicated to the Central Management network. The address of the adapter must be known by the 

Conviron Central Management software and the chamber. 

Both programs have settings that must agree with the Operating Systems TCP/IP setting. The 

Central Management Setting LCSNetwork and the chamber setting of the Unit ID must have the 

compatible TCP/IP settings as the Network Card allocated to the Central Management Chamber 

network. 

 

Figure 7-26 Internet Protocol TCPIP Settings 

See the following section for details of the software setting for Conviron applications. 

7.4 Central Management Software Settings 

7.4.1 Central Management Settings Panel 

 

Figure 7-27 Tools - Settings 

To configure options in Central Management, select Tools > Settings (Figure 7-27). 



 
 
 
 
 
Central Management Operator’s Manual System Maintenance and Troubleshooting 

 

 

June 2018 | 283442-ENGR01  126 

The Central Management Settings panel has six sections for configuration information: 

 Alarms 

 DCS 

 Debug Logging 

 Email 

 Server 

 SMTP Mail Server 

7.4.2 Alarms 

 

Figure 7-28 Alarms Settings 

Table 7-2 lists and describes the options in the Alarms Settings section (Figure 7-28). 

Table 7-2 Options in the Alarms Settings Section 

Option Description 

AlarmDelay Delays the alarm activation of email, audible, and Dry Contact 
System. The value is specified in seconds, with a settable range 
of 1-999. 

AudibleAlarmPriority Enables a short tone every ten seconds for an unacknowledged 
alarm that is less than or equal to the Audible Alarm Priority 
setting. The alarm priority setting for each chamber’s specific 
alarm condition is set in the Local Control System or Chamber’s 
control system. 

DCSAlarmPriority Enables the DCS (Dry Contact System) to trigger contacts at the 
set priority value or less. Any Local Control System alarm of the 
priority 1 to 20 inclusive will trigger the contacts. 

EmailAlarmPriority Enables the alarm priority number, which is compared to every 
chamber alarm. If the Alarms priority number is less than or equal 
to the value in this setting, then Central Management will send an 
Email Alert notification action to all identified users. 
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Option Description 

ThumbnailDropDelay The time (in seconds) will delay the triggering of a 
“Communication lost” alarm when a Local Control System 
disconnects from Central Management. This setting exists to 
provide compatibility with previous versions of the Local Control 
System software that dropped connections intermittently, causing 
nuisance alarms. 

To disable this function, set the value to zero. 

ThumbnailDropPriority The value in this setting is the alarm priority number applied to the 
“loss of communication” alarm between the Local Control System 
and Central Management. The priority setting will determine 
Central Management’s notification action. 

7.4.3 Dry Contact System 

 

Figure 7-29 Alarm - DCS Settings 

Table 7-3 lists and describes the options in the Dry Contact System section (Figure 7-29). 
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Table 7-3 Options in the DCS Setting 

Option Description 

AudibleAlarm When enabled, the Audible alarm emits a short tone every ten 
seconds for an Unacknowledged alarm that is less than or equal to the 
Audible Alarm Priority setting. The alarm priority setting for each 
chamber’s specific alarm condition is set in the Local Control System 
or chamber’s control system. 

To enable the Audible alarm, set to True. 

To disable the Audible alarm, set to False. 

DCS Reset Interval A delay in seconds that the Central Management system will wait, 
before resetting the Dry Contacts System after an alarm has occurred. 

To specify no interval, set the value to zero. 

EnableSanityReset By default, the value is set to True, which means this option is 
enabled, ensuring continuous operation of the Central Management 
system. In the event of PC lockup due to a transient malfunction, the 
PC will be forced to restart. 

7.4.4 Debug Logging 

 

Figure 7-30 Debug Logging 

By default, this option is set to False. However, Conviron Client Services may request this option 

to be set to True, which enables this option. When this option is enabled, detailed debugging log 

files are generated. 

7.4.5 Email 

 

Figure 7-31 EMail Local Settings 
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Table 7-4 lists and describes the options in the Dry Contact System section (Figure 7-31). 

Table 7-4 Options in the Email Setting 

Option Description 

EmailFromAddress The email address that Central Management will use for the 
Email Alert Message. This email address can be different from 
the SmtpUserID. 

EmailMaxAttempts The maximum number of attempts that the Central Management 
system will try to send an email alert. 

EmailRetryDelay The time in seconds that the Central Management system will 
wait before trying to resend an email if the SMTP server was not 
available. 

You can enter a value within the range of 0 to 99999. 

7.4.6 Server 

 

Figure 7-32 Server Setting 

Table 7-5 lists and describes the options in the Alarms Settings section (Figure 7-32). 

Table 7-5 Options in the Server Setting 

Option Description 

LCSNetwork Class B TCP/IP address. This is the first two octets of the Central 
Management network; for example, 192.168. 

For CMP5090 control systems or later, it is the first three octets; 
for example, 10.242.56. 

PublicVirtualChamberPort Defines the port that the Virtual Chamber software uses to 
communicate to the Chamber 
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Option Description 

PublicWebAddress The address used in this option appears in the email alerts that 
Central Management sends to the Email Subscribers. Users may 
browse to this address to view the Chamber status. The address 
is specific to each installation, as it typically reflects the Building 
Network Address. The Central Management system is shipped 
with the default address, and the onsite IT staff are responsible 
for providing the correct Building Network address. 

PublicWebPort Appended to the Public Web address to allow access to the Web 
Reports page using a web browser. For example: 
http://192.168.0.100:9001/?list 

7.4.7 SMTP Mail Server 

 

Figure 7-33 Mail Server Setting 

 

Table 7-6 Options in the Mail Server Setting 

Option Description 

SmtpAuthentication If your SMTP server requires authentication, then set the value to 
True. 

SmtpMailServer The address of your email server that Central Management will 
use to send Email Alert messages 

SMTPPassword If SmtpAuthentication is set to True, then enter the password. 

SmptPort Set to 0 (port 25) as a default. A different port is required for SSL 
or TLS. 
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Option Description 

SmtpUserID An email account. Enables send email access for Email Alerts to 
the mail server. 

SmtpUseSSL To enable TLS (SSL) encryption security, set the value to True. 

 

The settings and options discussed in Section 7.4, Central Management Software Settings, are 

assigned by the onsite IT department. If you are using an outside ISP email server, then contact 

their Technical Support for appropriate settings. Once the server settings are complete and the 

EmailFromAddress is set, email alerts will be enabled. The final task would be to assign users 

with email addresses to the Network Subscriber List or on individual Chamber’s Properties 

form. 

 

7.5 Web Reports 

7.5.1 Enable Web Reports 

Connect the Central Management Building adapter to the Network. 

1. On your computer, navigate to the Network Connections dialog box, and then select 
the Building Network Adapter. 

2. Right-click on the icon, and then select Properties. 

3. Select Internet Protocol Version 4, and then click Properties. 

4. Note the IP address. 

5. Enter this address in the Server settings, PublicWebAddress option (Figure 7-34). 

 

Figure 7-34 Server Settings 

Restart the Conviron CM Service to accept all Email and SMTP Server settings. 
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Contact your IT department and have them assign a static TCPIP address for the Building 

Network adapter.  

If external (Internet) access is to be provided, a default gateway and DNS server addresses may 

be required (Figure 7-35). 

 

 

Figure 7-35 Building Network (example only) 

7.6 Virtual Chamber Settings 

7.6.1 Central Management Client 

The Virtual Chamber, as part of the Central Management software package, uses the settings of 

the Central Management for locating the chambers by address.  

When you right-click on a thumbnail display and select Virtual Chamber, Central Management 

passes the network address and chamber number to the Virtual Chamber. No additional 

configuration is possible. 

All settings are site-specific. Consult your onsite IT Administrator for more information. 
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7.7 Firewall Settings 

7.7.1 Default Central Management Settings 

Firewall settings are shown as a reference in Table 7-7. Windows Firewall is enabled (by default) 

on the Conviron Central Management system.  

Table 7-7 Microsoft Firewall Settings 

Name Profile Enable Action 

Programs 

\Program Files 
(x86)\CM\ 

Local & 
Remote 
Address 

Protocol 
Local 
Port 

Remote 
Port 

Central 
Management 

All Yes Allow CentralManagement
.exe 

Any TCP Any Any 

CM Service All Yes Allow CMService.exe Any TCP Any Any 

CM Web 
Reports 

All Yes Allow Any Web Browser 
Any TCP 9001 Any 

Remote 
Control 

All Yes Allow RemoteControl.exe 
Any TCP 161 Any 

         

Virtual 
Chamber 

All Yes Allow VC.exe 
Any TCP Any Any 

Remote 
Desktop 

All Yes Allow System 
Any TCP 3389 Any 

 

Other security related programs will control the applications and external ports that are allowed to 

communicate with the outside world. This is normal behavior; however, these programs must 

have either permit rules or exceptions so you can authorize your communications program to use 

these ports to communicate.  

Settings similar to those set for the firewall will enable Central Management programs to 

communicate through the Intranet and Internet. At the Enterprise Firewall, the port 9001 must be 

forwarded to the Central Management system, to allow remote Internet users to be able to view 

the Web Reports (port 9001).  

Microsoft Remote Desktop protocol (3389) can be used to do a Central Management takeover 

and is recommended to be restricted to users with Administration level access. Microsoft software 

allows a single logon session at any given moment. When the remote desktop session is active, 

the Central Management console cannot be used, without disconnecting the remote user. 

Conversely, locally logging on to the Central Management system during a remote session will 

disconnect the remote user. 
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7.7.2 Third-party Client Software 

The following programs require attention to ensure Central Management and the alerting 

mechanisms are operating correctly and completely. 

 McAfee Antivirus and Intrusion Prevention 

 Trend Micro Antivirus and AntiSpyware 

This is not an exclusive list; certainly, other Security programs will require similar rules or 

exceptions to be added for Central Management operation. 

Add rules to allow the programs listed in Table 7-8 to have unrestricted access to the Central 

Control System Network. If Internet communications is utilized, then allow full Internet access. 

Table 7-8 Central Management Applications 

CentralManagement.exe RemoteControl.exe 

CMService.exe VC.exe 

To enable Internet access for Email, Virtual Chamber, and WebReports, open the following ports 

through any Firewall software: 

Table 7-9 Central Management Port Requirements 

SMTP (port 25) – Email SNMP (port 161) 

HTTP (port 9001) – Web Reports Port 9002 – VC Routing 

 

Call your onsite IT support before altering any security software settings. 

7.8 Central Management Backup 

7.8.1 Central Management Software-only 

The software-only installation provides the optional backup scripts that are provided with the 

Conviron Central Management full-hardware system.  

The required files for the automated backup system are provided in the C:\Program Files 

(x86)\CM\Util directory. These files need to be imported into the Windows task scheduler: 

 CMbak2_RestoreDrive.xm  

 Backup CMv84 Data to D partition.xml 

Before testing the backup system, first ensure that the appropriate hardware is in place and the 

Tasks are activated. 
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7.8.2 Central Management Hardware 

The Central Management application uses Windows Task Scheduler and Windows Backup to 

automatically enable backup tasks for hardware-based installations only. 

7.8.3 Task Scheduler 

The task “Backup CMv84 Data to D partition.xml“ is used to run a command script 

(CMv84bak2D.bat ) twice per hour to “backup” the application log files from C:\Program Files 

(x86)\CM directory and all the CHAMBERS and SITES subdirectories contents, to the D drive 

partition. 

Once per day the D drive directory CMbak is backed-up by the task “CMbak2_RestoreDrive.xml“ 

to the Conviron Restore Drive (Drive H:). 

The Conviron command scripts can be modified to suit any special requirements. These files 

ASSUME a hardware setup of a C and D partition of the hard drive and a Conviron Restore Drive 

installed. Windows Backup™ software copies only the updated files from the D:\CMbak directory. 

7.8.4 Backup Scripts 

@echo off 

rem Copyright 2016 Controlled Environments Limited, All Rights 

Reserved.bmc 

rem CMv84bak2D.bat for 64 bit Windows 7-10 

rem V1.7 5/20/2016 

echo %date%_%time%_Backup V84 to D drive started >> “C:\Program Files 

(x86)\CM\ActivityLogs\backup.log” 

xcopy “C:\Program Files (x86)\CM\Chambers\*.*” D:\CMbak\Chambers\ /E /D 

/C /K /Y 

xcopy “C:\Program Files (x86)\CM\Sites\*.*” D:\CMbak\Sites\ /E /D /C /K 

/Y 

xcopy “C:\Program Files (x86)\CM\ActivityLogs\*.log” 

D:\CMbak\ActivityLogs\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\AppLogs\*.log” D:\CMbak\AppLogs\ /C /K 

/Y 

xcopy “C:\Program Files (x86)\CM\*.license” D:\CMbak\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\*.mdb” D:\CMbak\ /C /K /Y 

 



 
 
 
 
 
Central Management Operator’s Manual System Maintenance and Troubleshooting 

 

 

June 2018 | 283442-ENGR01  136 

xcopy “C:\Program Files (x86)\CM\CCSNetwork.dll.config” D:\CMbak\ /C /K 

/Y 

xcopy “C:\Program Files (x86)\CM\CMService.exe.config” D:\CMbak\ /C /K 

/Y 

xcopy “C:\Program Files (x86)\CM\RemoteControl.exe.config” D:\CMbak\ /C 

/K /Y 

xcopy “C:\Program Files (x86)\CM\VC.exe.config” D:\CMbak\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\VC.vshost.exe.config” D:\CMbak\ /C /K 

/Y 

 

xcopy “C:\Program Files (x86)\CM\CentralManagement.xml” D:\CMbak\ /C /K 

/Y 

xcopy “C:\Program Files (x86)\CM\CMSettings.xml” D:\CMbak\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\CMService.xml” D:\CMbak\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\folders.xml” D:\CMbak\ /C /K /Y 

xcopy “C:\Program Files (x86)\CM\VCClient.xml” D:\CMbak\ /C /K /Y 

 

xcopy “C:\Program Files (x86)\CM\Chambers.txt” D:\CMbak\ /C /K /Y 

echo %date%_%time%_Backup V84 to D drive completed >> “C:\Program Files 

(x86)\CM\ 

ActivityLogs\backup.log” 

7.8.5 Xcopy Command Syntax 

Copies files and directory trees and is used in the backup scripts to quickly update the backups. 

This command tool may be modified to the client’s needs. 

XCOPY source [destination] [/A | /M] [/D[:date]] [/P] [/S [/E]] [/W] [/C] [/I] [/Q] [/F] [/L] [/H] [/R] [/T] 

[/U] [/K] [/N] 

Options Description 

source Specifies the file(s) to copy 

destination Specifies the location and/or name of new files 

/A Copies files with the archive attribute set; doesn’t change the attribute 

/M Copies files with the archive attribute set; turns off the archive attribute 

/D:date 
Copies files changed on or after the specified date. If no date is given; copies 
only those files whose source time is newer than the destination time 
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Options Description 

/P Prompts you before creating each destination file 

/S Copies directories and subdirectories except empty ones 

/E 
Copies directories and subdirectories, including empty ones. Same as /S /E. 
May be used to modify /T. 

/W Prompts you to press a key before copying 

/C Continues copying even if errors occur 

/I 
If destination does not exist and copying more than one file, assumes that 
destination must be a directory. 

/Q Does not display file names while copying 

/F Displays full source and destination file names while copying 

/L Displays files that would be copied 

/H Also copies hidden and system files  

/R Overwrites read-only files 

/T 
Creates directory structure, but does not copy files. Does not include empty 
directories or subdirectories. /T /E include empty directories and subdirectories. 

/U Updates the files that already exist in destination 

/K Copies attributes. Normal Xcopy will reset read-only attributes. 

/Y Overwrites existing files without prompting 

/-Y Prompts you before overwriting existing files 

/N Copy using the generated short names 

7.9 Software Restore  

7.9.1 Restore Overview 

 

First, restart the CM system and boot into the Restore Drive.  

Second, select the System Image restore and choose the image from the Conviron Restore drive. 

Finally, reload your personal applications added to Central Management after original delivery. 

Example: Anti-Virus program. 

All software is preloaded into the PC. The following information is required only for 

emergency reinstallation. 
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7.9.2 Restore Procedures 

Procedure for CM software versions prior to v8.5 and non-Dell hardware: 

1. On your computer, select the Start > Shut Down > Restart (Figure 7-36).  

 

Figure 7-36 Restart Sequence, Prior to CM v8.5 and Non-Dell Hardware 

2. As soon as the system’s beep is heard, press the F8 key a couple times slowly to start 
the Boot menu. If you miss the timing to start the Boot menu, wait until the system has 
fully started, restart the computer again, and repeat the process. 

3. Select the Conviron Restore Drive. Wait until the system starts.  

4. From the Select a keyboard input method menu, ensure that US is selected, and then 
click Next.  

5. In the following message that appears, click No. Do not click Repair and Restart. 

6. Select Restore your computer using a system image, and then click Next.  

Backup all critical data before using the Restore Process, as the C:\ drive will be 

erased. All changes to the Central Management PC since initial startup will be lost. 

Chamber data is stored in the C:\Program Files (x86)\CM\Chambers directory. It is 

recommended to save all files in the CM directory with the file extensions of LOG, 

XML, MDB, PGM, ALE, CP4, LICENSE and TXT. By default, the Autobackup 

application has saved all the chamber data to the D: drive (partition) and H: Conviron 

Restore drive. 

 

Only drive C:\ is affected by the restore process. 
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7. Select Use the latest available system image, and ensure that location is specified to 
the Conviron Restore drive.  

8. Click Next. When the software reinstallation is complete, the computer restarts. The 
chambers automatically log on within a period of ten minutes. 

9. Once the system has been restored, copy backup data from either D:\CMbak or 
Conviron Restore Drive\CMbak (Auto backup) backups to the Central Management 
installation location on C drive. This step updates your system’s data from the factory 
settings up to the date of your last backup. 

10. Reload your personal applications added to Central Management after the original 
delivery. For example, an Anti-Virus program. 

 

 

Procedure CM software v8.5 and Dell-Windows 10 systems: 

1. Connect the “Windows 10 Pro OS Recovery” USB device to the CM PC and select the 
Start Menu->Shutdown->Restart. 

2. As soon as the system beep is heard, tap the F8 key a couple times slowly. This will 
start the Boot Menu. If you miss the timing to start the boot menu, wait until the system 
has fully started up, then repeat the ”Restart” process until you view the Boot Menu. 

3. Select the Windows 10 Pro OS Recovery USB drive. Wait until the system starts. 

4. Select TROUBLESHOOT, then ADVANCED OPTIONS, then SYSTEM IMAGE 
RECOVERY (Figure 7-37). 

   

Figure 7-37 System Image Recovery Sequence, CM v8.5 and Dell-Windows 10 Hardware 

5. At the System Recovery Options dialog, select “Keyboard” leave “US” highlighted 
and Select “Next”.  

6. At the System Recovery Options dialog “Windows found problems.”, select “No”. 
Do Not Select “Repair and Restart”. 

Call 1-800-363-6451 or +1-204-786-6451 for Conviron Technical Services, if 

assistance is required. 
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7. At the next System Recovery Options dialog, select “Restore your computer using a 
system image” and select “Next”. 

8. At the System Recovery Options dialog, “Select a System Image Backup”, select 
“Use the latest available system image”, Location must be “Conviron Restore” drive, 
then select “Next”. 
With Windows 10 you may need to search for the drive/location, as it is not on the boot 
drive. 

9. Once image is identified, select “Next” and follow the default prompts to complete the 
process. 

10. If the previous procedure did not automatically restart the PC, do so now. Once the 
system is running login and ensure CM applications are working. 

11. Lastly, when the software is shown to be correctly installed, copy the backup data 
(chamber logs and CM configuration) into the C drive CM application directory. 
Windows updates and any third party software can now also be updated or reinstalled. 

7.10 Creating a New System Restore Image 

Remember to replace the restore image after any major changes, such as an application 

installation. 

1. Follow the Microsoft Backup instructions to make a System Image of the C drive 
(including the system partition, which is the default setting). 

2. Save the system image to a DVD or external drive and store the media safely for future 
use. 

 

7.11 About Information 

To determine the Central Management version number, from the Help menu, select About 

(Figure 7-38). 

 

Figure 7-38 CM Version Sequence 

You may replace the “factory system image” on the Conviron Restore Drive, but do 

this at your own risk. Once it has been replaced, you have only your current image for 

recovery options. 
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The version numbers appear on the upper half of the About Central Management dialog box 

(Figure 7-39). 

 

Figure 7-39 About Central Management, Version 

To locate the Central Management serial number, check the side of the PC for a card similar to 

Figure 7-40. 

 

Figure 7-40 Serial Number 
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8 INSTALLING CENTRAL MANAGEMENT 

8.1 Central Management v8.5 Install Procedure 

The Central Management Software is provided differently depending on how it is purchased. 

Software-Only purchasers are provided with a download link to the current version. Those who 

purchase the full hardware turn-key system have all the OEM software on the Restore Drive of the 

CM systems, in both Image and Installation forms. 

Note: The software has several requirements. 

 The login ID of the first user is to be conviron. 

 All CM users must have local machine administration privileges. 

 Local machine user must have full access to the CM directory. 

 User Access Controls (UAC) must be disabled. 

 Windows Firewall rules must be added for CM processes - see the Operator’s Manual 
for more information. 

8.2 Software Only 

1. After downloading the files, copy the Central Management v8.x Installation software 
CONVIRON INSTALL SOFTWARE.ZIP supplied by Conviron to your target computer 
desktop.  

2. Open the ZIP archive and extract the contents to the desktop with Windows Explorer.  

3. Open the OEM INSTALL SOFTWARE folder and open the file ReadMe1st-85.txt.  

4. Select and install using the recommended install software. 

 Set TCP/IP address for ON-Board Ethernet (Chamber Network), as indicated by 
the installation program. (Typically address 192.168.0.100 and netmask 
255.255.255.0).  

 A second Network card (Building Network) can be installed and could be 
configured by on site I.T. staff to be used on the local client Network.  

 Install the current version of Adobe Reader to be able to view the Conviron 
Operator’s Manuals.  

 To verify that the installation is successful, open the Central Management 
Operator’s Manual, and navigate to Section 2.4 Starting and Quitting Central 
Management to start Central Management.  
ActivationCentral Management Software will operate as TrialWare and will expire 
in 30 days, after which a license file is needed to continue using it. You can 
activate Central Management at any time, by running help.about.license. 
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5. Copy and send the machine ID to Conviron by email or phone at: 
centralmanagement@conviron.com or phone 204-786-6451 

Conviron emails the license file 

6. Copy the license file to the Central Management installation directory: C:\Program 
Files\CM or C:\Program Files (x86)\CM 

8.3 Activation 

Central Management Software will operate as TrialWare and will expire in 30 days, after which a 

license file is needed to continue using it.  

1. To activate Central Management, double-click Help-About-License. 

 

Figure 8-1 About Central Management, Machine ID 

2. Copy and send the machine ID to Conviron by email or phone: 
centralmanagement@conviron.com or phone 204-786-6451  

Conviron supplies a license file.  

3. Copy the license file to the Central Management installation directory: C:\Program Files 
(x86)\CM. 

8.4 Starting 

To start the Central Management program:  

 On the computer desktop, double-click the Central Management icon .  

 On the computer, select Start > Conviron > Central Management. 
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9 GLOSSARY 

Term Definition 

Building Network The existing premise computer network 

Cascade To arrange open windows on the desktop so that they overlap 
each other 

CCS Central Control system – the monitoring program of legacy 
chambers 

Central Management Application software designed by Conviron for total Phytotron 
management 

Central Management network The physical connection of growth chambers to the central 
control computer 

Cell The smallest unit of information on a program table 

Chamber The growth chamber unit, including the control system, growth 
area, and control systems 

Chamber program A series of time lines which are entered into the program table 
telling the control system how to set conditions in the growth 
chamber over a 24-hour period 

CMP Conviron Microprocessor Programmer 

Controller The computer that sets, directs, and records the conditions in 
the growth chamber 

Conviron Restore Drive Hard Drive permitting a Bootable Windows 7 Repair system 
including the Operating System Image and the latest CM 
application data backup 

DCS Dry Contact System; relay contacts for alarm indications to 
auxiliary systems 

Download Sending data to the Central Management system from a 
Chamber control system 

Ethernet The type of local area network used by the Central Management 
system to connect to the chambers 

Export To copy and convert a file to a different format so that it can be 
opened by another application 

Extract To copy or display selected records 
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Term Definition 

Host The Central Control System – legacy chamber monitoring 
program 

Icon A small graphic that represents a Windows element such as a 
program, directory, window, or any file 

Import To open and convert a file that has a format different from an 
application’s standard format 

Label The name used by the control system for an output or alarm 

Load To install software 

LCS Local control system or Conviron Chamber control system 

Menu bar The horizontal bar located near the top of the program window 
containing the program’s menus. You can access all of the 
programs commands from the menu bar. 

Output Switches that control specific equipment or conditions within the 
chamber 

Phytotron A controlled environment facility with plant growth chambers 
and/or controlled greenhouses for scientific research 

Program spreadsheet See program table 

Program table A series of columns and rows for entering program time lines on 
the chamber’s Program Spreadsheet or the VC’s Program Editor 

Reinstall To run an application software installation after it has been 
completely removed 

Remote control Chamber operations accessed remotely using the Remote 
Control software, for Programming and Schedule operations 

 

Restore Complete operating system and application replacement to an 
image created at an earlier date. A fast complete recovery 
method. 

Thumbnail An icon located in the Central Management system or Web 
Reporting’s Chamber Status window that display the current 
conditions of a growth chamber connected to the network. 

Toolbar The horizontal bar located near the top of the program window 
containing icons for commonly used commands 
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Term Definition 

Upgrade To load a new software version 

Upload To send data from a chamber control system to the Central 
Management system 

Virtual chamber Chamber operations using the chamber touch screen remotely 
using the VC software, “viewing” the actual chamber screens in 
real time 

Zone An area of the growth chamber that is controlled and/or 
monitored by the control system 
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